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About this Guide 
Welcome to iFIX®! Thank you for taking the time to install and use iFIX.  

Before you begin installing our product, please take some time to review this Getting Started guide. 
The guide includes information about the following: 

• Installing iFIX  

• Upgrading from earlier versions of iFIX  

• Supported networking components  

Reference Documents 

For more information on the System Configuration Utility, troubleshooting your set-up, working with 
the Proficy iFIX WorkSpace, or setting up a process database or SCADA system after you install iFIX, 
please refer to the following electronic books: 

• Setting Up the Environment  

• Understanding iFIX  

• Building a SCADA System  
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General Installation Information 
This chapter provides general information you need in order to install iFIX including: 

• Hardware requirements, including required computer hardware, recommended computers, 
required memory, and required hard disk space.  

• Installing the hardware key and replacing defective keys.  

• Installing iFIX, or iFIX with FIX Desktop. 

• iFIX software requirements, including operating systems, supported regional settings, video 
drivers, optimizing virtual memory, and running iFIX as a service.  

• Optional installation features, including online registration, and installing optional hardware.  

• Installing iFIX with other applications including FIX Desktop, Microsoft® Office, and 
Proficy Change Management. 

Set-up Overview 
When you are ready to begin setting up your iFIX environment, use the following steps to set up your 
nodes. 

To set up your nodes: 

1. Set up each computer you require. Use the section Hardware Requirements as a guide and 
refer to the user manual that accompanies each computer for detailed setup information.  

2. Install and optimize Microsoft Windows on each computer as needed. Also make sure you 
create a login account with administrator rights so you can install iFIX later. For instructions 
on optimizing Windows, refer to the Optimizing Virtual Memory section.  

3. Set up the network adapters and network software required for each computer. Refer to the 
Networking iFIX Nodes and Advanced Topics chapters of the Setting Up the Environment 
manual for more information.  

4. Install iFIX and any other hardware you may have purchased. Refer to the Installing the iFIX 
Software section for instructions on installing iFIX and your hardware key. For information 
on installing other hardware, refer to the that product's documentation.  

5. Configure iFIX on each computer. Make sure that the user installing iFIX is a member of the 
Administrators Windows group. Refer to the Configuring iFIX Using the SCU chapter of the 
Setting Up the Environment manual for more information on configuring iFIX.  
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Hardware Requirements 
The minimum iFIX hardware requirements are: 

iFIX without Enhanced Failover or Historian Server 

For Proficy HMI/SCADA - iFIX computers, the recommended minimum hardware requirements are: 

• A minimum Pentium 3-based 733 MHz computer. For optimum performance, GE Fanuc 
recommends a Pentium 4-based 1 GHz computer.  For a list of machines tested by GE Fanuc, 
refer to the Recommended Computers section.  

• A minimum of 512 MB RAM. Refer to the Memory Requirements section for more 
information.  

• A minimum of 1 GB of free hard drive space to install a typical iFIX system, including 
pictures, databases, alarm files, other data files, and help.  

• iFIX alarm and historical data files grow dynamically. If you plan to perform extensive alarm 
or data collection on a node, you may need more disk space on that particular node.  

• Other GE Fanuc products, such as Proficy Plant Applications, Proficy Historian, and Proficy 
Real-Time Information Portal, impose additional requirements. Refer to the Important 
Product Information (IPI) topic in the product's electronic books for specific system 
requirements. Click the System Req. tab in that product's IPI for details. 

• A DVD drive. 

• TCP/IP-compatible network interface adapter for network communication and certain I/O 
drivers.  

NOTE: iFIX no longer supports NetBIOS. 

• One parallel port or free direct-connect USB port. Some touch screens, pointing devices, and 
I/O drivers require a serial port. Additional ports for I/O hardware should be ordered with the 
computer. 

• SVGA or better color graphics monitor and a 100% IBM-compatible, 24-bit graphics card 
capable of 800x600 resolution and at least 16 million (16,777,216) colors.  

• Two-button mouse or compatible pointing device (such as a touch screen).  

iFIX with Enhanced Failover Enabled 

For Proficy HMI/SCADA - iFIX computers with SCADA Enhanced Failover features enabled, the 
recommended minimum hardware requirements are (for both primary and secondary computers): 

• A 2 Ghz Dual-Core CPU.  

• A minimum of 2 GB RAM. 
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• It is strongly recommended that you use 1 additional Gigabit-Ethernet card for dedicated 
SCADA-to-SCADA traffic (for a total of at least 2 network cards).  

• A minimum of 1 GB of free hard drive space.  

• iFIX alarm and historical data files grow dynamically. If you plan to perform extensive alarm 
or data collection on a node, you may need more disk space on that particular node.  

• Other GE Fanuc products, such as Proficy Plant Applications, Proficy Historian, and Proficy 
Real-Time Information Portal, impose additional requirements. Refer to the Important 
Product Information (IPI) topic in the product's electronic books for specific system 
requirements. Click the System Req. tab in that product's IPI for details. 

• A DVD drive. 

• TCP/IP-compatible network interface adapter for network communication and certain I/O 
drivers.  

• One parallel port or free direct-connect USB port. Some touch screens, pointing devices, and 
I/O drivers require a serial port. Additional ports for I/O hardware should be ordered with the 
computer. 

• SVGA or better color graphics monitor and a 100% IBM-compatible, 24-bit graphics card 
capable of 800x600 resolution and at least 16 million (16,777,216) colors.  

• Two-button mouse or compatible pointing device (such as a touch screen).  

iFIX with Historian Server 

For Proficy HMI/SCADA - iFIX computers with Proficy Historian Server, the recommended 
minimum hardware requirements are: 

• A 2 Ghz Dual-Core CPU.  

• A minimum of 2 GB RAM. 

• If using the Enhanced Failover feature, it is strongly recommended that you use 1 additional 
Gigabit-Ethernet card for dedicated SCADA-to-SCADA traffic (for a total of at least 2 
network cards).  

• A minimum of 1 GB of free hard drive space.  

• If also using Classic Historian, iFIX alarm and historical data files grow dynamically. If you 
plan to perform extensive alarm or data collection on a node, you may need more disk space 
on that particular node.  

• Other GE Fanuc products, such as Proficy Plant Applications, and Proficy Real-Time 
Information Portal, impose additional requirements. Refer to the Important Product 
Information (IPI) topic in the product's electronic books for specific system requirements. 
Click the System Req. tab in that product's IPI for details. 
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• A DVD drive. 

• TCP/IP-compatible network interface adapter for network communication and certain I/O 
drivers.  

• One parallel port or free direct-connect USB port. Some touch screens, pointing devices, and 
I/O drivers require a serial port. Additional ports for I/O hardware should be ordered with the 
computer. 

• SVGA or better color graphics monitor and a 100% IBM-compatible, 24-bit graphics card 
capable of 800x600 resolution and at least 16 million (16,777,216) colors.  

• Two-button mouse or compatible pointing device (such as a touch screen).  

Recommended Computers 

iFIX has been tested by GE Fanuc on the following machines that were running Microsoft® 
Windows® XP, Windows Server 2003, or Windows Vista™: 

• Compaq Deskpro  

• Dell Optiplex GX200  

• Dell Optiplex GX280 

• Dell Optiplex GX620 

• Dell Optiplex 745 

• Dell Precision 340  

• Dell Precision 420 

• Dell Precision 470 Dual Xeon  

• Dell Precision 530 Dual Xeon  

• IBM NetVista  

• Electrovaya Scribbler SC 2100 Tablet PC (Microsoft Windows XP Tablet Edition or 
Windows Vista, iClient Only)  

While GE Fanuc cannot guarantee the integrity of any computer, our testing has shown a higher 
potential for problems with the economy lines of computers on the market. Because of these problems, 
GE Fanuc does not recommend the use of value or economy type computers with iFIX. Instead, GE 
Fanuc recommends you invest in the higher end (premier) line of computers when purchasing 
computer hardware. 
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Memory Requirements 

iClients and SCADA nodes require at least 128MB RAM. This configuration provides enough memory 
to run iFIX applications.  

NOTE: As more applications run simultaneously on a SCADA server, performance decreases. 
Whenever possible, run additional applications on different computers. 

If the size of your process database is over 1MB, add 1 megabyte of memory for each megabyte of 
database size. For example, if your database is 2MB in size, your SCADA server requires 130MB 
minimum (128+2=130). 

If your picture cache size increases, your memory requirements should increase: 

• 2 to 3 times the file size for each picture that does not include bitmaps and controls.  

• 3 to 4 times the file size for each picture that includes bitmaps and controls.  

For example, a 2 megabyte file that does not include bitmaps and controls requires a 4 to 6 megabyte 
increase in memory. A 2 megabyte file that includes bitmaps and controls requires an increase in the 
memory of 6 to 8 megabytes. 

Disk Space Requirements 

The Proficy iFIX WorkSpace checks to make sure you have at least 10 MB of disk space when you 
save a picture or a schedule. If there is insufficient disk space, the WorkSpace may react unpredictably 
and you may lose your work. 

To help minimize this problem, the WorkSpace warns you if you have less than 10 MB of disk space 
available. Although you can continue loading the software, we recommend that you stop iFIX, free 
some disk space, then restart. Otherwise, the WorkSpace may become unstable. 

The WorkSpace examines the iFIX Picture path and the Windows TEMP path when it starts. If you 
change either path so that they reference different drives, for example, D:\Program Files\GE 
Fanuc\Proficy iFIX and C:\Temp, the WorkSpace requires 10 MB on each drive. 

You may find that 10MB is not enough space to protect against instability during file save operations. 
You can increase this threshold by changing the FreeDiskSpace parameter in the 
FixUserPreferences.ini file. This parameter sets the minimum amount of space that the WorkSpace 
requires in bytes. By default, the parameter is set as follows: 

[AppRunPreferences] 

FreeDiskSpace=10000000 

To change FreeDiskSpace parameter:  

1. Shut down the WorkSpace.  

2. Locate the FixUserPreferences.ini file in the Local path.  

3. Open the file with a text editor, and change the FreeDiskSpace parameter to the amount you 
want.  

4. Save the .INI file and restart the WorkSpace.  
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The Hardware Key 
Two types of hardware key are currently offered: one that supports parallel port configurations, and a 
key that supports USB port configurations. The hardware key you use to run iFIX: 

• Controls and enables software options available to your installation.  

• Uses a utility to electronically reprogram options you choose to upgrade or change (for HASP 
M1 or M4 keys only).  

iFIX runs in demo mode for two hours if the key is not installed or found. Hardware keys from version 
2.5 and older will not work with the current version of iFIX. The iFIX 2.6 SuperPro keys also do not 
work with iFIX 5.0. iFIX 5.0 only supports HASP M1 and M4 keys.  

NOTES:  

• In some cases, an electronic file update is not available for reprogramming your key.  

• If you want to upgrade an earlier version of iFIX that came with a Rainbow SuperPro or 
C++  key, you will need to exchange your key for new one. Typically, this includes SuperPro 
keys from iFIX 2.6, and any 2.5 or earlier release.   

• Additionally, if you want to upgrade iFIX to run with other Proficy products, such as Proficy 
Change Management or Proficy Plant Applications, you will also be required to exchange 
your hardware key for a new M4 key.  

• You can exchange the older key by contacting your iFIX sales representative.  

Be sure to file your hardware key packing slip in a safe location. The codes on this slip are necessary 
for GE Fanuc to quickly duplicate the key in case it is damaged or misplaced. You can verify that your 
serial number matches the serial number on the hardware key packing slip by using the iKeyDiag or 
the Proficy License Viewer utility to detect and display your hardware key settings. For more 
information, see the License and Key Checking section. 

Installing the Hardware Key 

A hardware key is included with your iFIX software. You must install your hardware key in order to 
access all the components of the iFIX software you purchased.  

Typically, you install your hardware key as you install the iFIX product. Refer to the Installing the 
iFIX Software section for more details. If you are upgrading from a previous version, you usually run 
the electronic licensing update file for your key before installing the newer version of iFIX. 

If you insert the key after you install iFIX, it should be detected automatically when iFIX starts. It is 
recommended that you shutdown your computer before plugging in a new hardware key.  

IMPORTANT: Do not remove the hardware key from your node while iFIX is running. If you do, iFIX 
features will shut down and you will need to restart iFIX. You may also damage the hardware key if 
you remove it while iFIX is running. 

GE Fanuc supports the installation of the USB port hardware key only on systems running Windows 
XP, Windows Server 2003, or Windows Vista. At this time, GE Fanuc does not support USB keys 
connected through an external USB hub.  

On new installs on Windows XP SP1, GE Fanuc recommends that you insert your USB key after you 
run the iFIX install. 
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License and Key Checking 

To use iFIX and other GE Fanuc products, you must purchase the product with the desired options 
from GE Fanuc. Depending on the options you buy, you may need to replace your current key or run 
an update program on your existing key to enable the options. If you are upgrading from an earlier 
version of iFIX, you will also need to update or replace your key.  

If you want to determine the options that are enabled on the computer you are currently working on: 

• For older keys (M1 HASP keys), use the GE Fanuc iKeyDiag utility to view the options 
enabled.  

• For newer keys (M4 HASP keys), use the Proficy License Viewer to view the options 
enabled.  

NOTE: If you try to run iKeyDiag and a newer key is installed, an error message appears. Similarly, if 
you try to run the Proficy License Viewer when an older key is installed, an error message appears. 
Should an error message appear, try starting the other utility to view the enabled options. 

TIP: Both the iKeyDiag or the Proficy License Viewer programs can be used to provide technical 
support personnel with information about your iFIX hardware key.  

To use iKeyDiag to determine the enabled options:  

1. Click the Start button and then point to Run. The Run dialog box appears.  

2. In the Open field, enter iKeyDiag.  

3. Click OK. The iKeyDiag utility appears.  

IMPORTANT: If you run iKeyDiag while running the Sample System, the information 
displayed will reflect settings on a demo key, rather than the actual settings of your hardware 
key. To see your hardware key settings, close the Sample System before running iKeyDiag. 

4. Click the iFIX tab to view the installed product options.  

For information on upgrading your key to include other options, contact GE Fanuc. You may 
need to use the iKeyUpdate utility to update your key, or obtain a new key to add options or 
work with other Proficy products.  

NOTE: The key_report.txt file generated by iKeyDiag is used only by GE Fanuc Technical 
Support; in localized versions, its content remains in English.  

To use the Proficy License Viewer to determine the enabled options:  

1. From the Start menu, point to Programs, Proficy Common, and then License Viewer. The 
License Viewer appears. 

2. In the Proficy Products list, select the iFIX product. The License and Key Diagnostics area 
should now display the iFIX options. 

3. For information on upgrading your key to add other options, contact GE Fanuc. GE Fanuc 
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will provide the steps for upgrading your Proficy license file when you purchase new options 
or products.  

Troubleshooting Hardware Key Installation 

If the hardware key does not install properly, you may find that even though you have followed the 
installation directions for your hardware key, you see the following message at iFIX startup: 

 

Message when No Key is Detected 

First, check to see that your hardware key is firmly attached. Next, uninstall and reinstall the driver for 
the hardware key. If this driver has been incorrectly uninstalled, it may behave unpredictably. 

Troubleshooting the Aladdin HASP USB Key... 

If the Aladdin HASP USB key does not appear to be working, you can reinstall the licensing to recover 
from the improper install. When the Aladdin HASP key is not communicating correctly, you will 
notice that the indicator light at the end of the key is off.  

NOTE:  iFIX 5.0 supports two types of HASP keys: the M1 and M4 keys. If you upgraded from an iFIX 
3.5 computer with a HASP key, the HASP key is typically an M1 key. However, if you want to run iFIX 
with other Proficy products, such as Proficy Change Management, you will need to upgrade to an M4 
key. For new iFIX 5.0 installs, the HASP key is typically the M4 key.  

To reinstall the GE Fanuc Proficy Licensing if you have an M1 key:  

1. Reinstall the licensing by clicking the M1Licensing.exe file in the License folder on the iFIX 
product installation CD.  

2. Click Finish when the licensing install completes.  

To reinstall the GE Fanuc Proficy Licensing if you have an M4 key:  

1. Reinstall the licensing by clicking the ProficyClientInstaller.exe file in the License folder on 
the iFIX product installation CD.  

2. Click Finish when the licensing install completes.  
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Replacing Defective Hardware Keys 

A defective hardware key causes your Proficy product to run in Demo mode. In iFIX, that means you 
will only be able run in iFIX in DEMO mode.  

Be sure to check that the key is firmly attached to your USB or parallel port before assuming it is 
defective. Additionally, for USB keys, if the indicator light at the end of the key is off, then the key is 
not communicating correctly. 

You can also use the License Viewer (for M4 keys) or iKeyDiag (for M1 keys) to determine if the 
hardware key is defective. If your hardware key is defective, the License Viewer or iKeydiag does not 
display the proper enabled options. Or, an error message stating that a hardware key is required to view 
the enabled options may appear. For more information on using the License Viewer, refer to the 
License and Key Checking section. 

GE Fanuc replaces defective keys as quickly as possible. To obtain a replacement hardware key: 

• Call your local GE Fanuc technical support representative. The support representative will 
instruct you to FAX a completed copy of a Merchandise Return Authorization form. On 
receipt of the form, GE Fanuc can program a new hardware key and send it to you overnight.  

• When you receive the hardware key, you must return the old one along with a copy of the 
form sent with the new hardware key. GE Fanuc reserves the right to invoice you for 
defective hardware keys that are not returned.  

Common Questions About Hardware Keys 

This section describes some frequently asked questions about iFIX hardware keys. 

What's the Difference Between the HASP and SuperPro Keys? 

The Aladdin HASP (M1 or M4) key is the newer hardware key that is provided with the iFIX 4.0 and 
later products. iFIX 2.6 first released with the SuperPro key, but GE Fanuc later offered the HASP M1 
key for iFIX in 2002. All iFIX releases after 2.6 include support for the M1 key. iFIX 4.0 was the first 
iFIX release to offer the M4 key. iFIX 4.5 and 5.0 supports only the M1 and M4 keys. 

The Rainbow SuperPro (Sentinel) USB Key was first offered in iFIX 2.6. It was also supported in iFIX 
3.0 and 3.5. If you are upgrading from one of these releases, you may have a SuperPro key. These keys 
must be exchanged for newer keys if you want to upgrade to iFIX 4.5. The SuperPro USB key is a 
lighter purple than the newer keys. 

The version and type of key you have should appear imprinted on the outside of the key. If you do not 
know the type of key you have, read the label on the physical key. 

What Does the Light At the End of the USB Key Indicate? 

For the Aladdin HASP USB Key, the light indicates that the key and the software are communicating. 
If this light is off, it indicates a problem with the key. 

For the Rainbow SuperPro USB Key, the light simply means that it is plugged in. It does not indicate if 
it is running correctly. This key is not supported in iFIX 5.0.  

If I Move the USB Key To Another Port Is It Automatically Detected?  

Yes. The USB key is automatically detected when moved to another USB port. There are no additional 
screens requesting software to be installed for the Aladdin HASP USB key. 
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Software Requirements 
The minimum iFIX with FIX Desktop software requirements are: 

• One of the following operating systems:  

• Microsoft® Windows® XP Professional, Service Pack 2 or greater. Since Windows XP 
has continuous updates, you should run the Windows update feature to get the latest 
software.  

• Microsoft® Windows® Server 2003, Standard or Enterprise Edition. Since Windows 
Server 2003 has continuous updates, you should run the Windows update feature to get 
the latest software. 

• Microsoft® Windows® Vista™, Business, Enterprise, or Ultimate Edition. Since 
Windows Vista has continuous updates, you should run the Windows update feature to 
get the latest software. 

• Microsoft® Windows® Vista™ Ultimate Edition running on a Tablet PC, iClient Only. 

NOTE: Proficy Historian is not available for use in Windows Vista. Proficy Historian 
currently does not support Windows Vista. 

• Microsoft® Windows® XP Tablet Edition, iClient Only. 

• Network interface software for TCP/IP network communication and certain I/O drivers.  

• An I/O driver for SCADA servers. GE Fanuc supplies I/O drivers for many programmable 
controllers or you may purchase a driver separately. Be certain that the I/O driver you 
purchase is compatible with your hardware. Contact your GE Fanuc Sales Representative or 
visit the GE Fanuc web site at http://www.gefanuc.com for the latest list of drivers and 
supported hardware.  

• Internet Explorer 6 or 7.  

• One of the following relational database applications, if relational database software is used 
with iFIX:  

• Microsoft® SQL Server 2000 (SP4 and higher).  

• Microsoft® SQL Server 2005 (SP2 and higher).  

NOTE: If you plan to use SQL Server in Windows Vista, you must use Microsoft® SQL 
Server 2005. Microsoft Windows Vista does not support SQL Server 2000. 

• Oracle® 10g.  

• Oracle® 11g.  

• Microsoft® Access 2000 (or higher). Microsoft Access is supported for local installs 
only.   
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Third-Party Software Installed During the iFIX Install 

Please note that Microsoft® VBA 6.4 software is automatically installed with iFIX. If the versions of 
VBA on the iFIX DVD are newer than the versions on your computer, then the iFIX install updates the 
version on your computer.  

Supported Regional Settings 

iFIX supports the following regional settings available in the Windows Control Panel: 

• Decimal symbol - one character  

• Digit grouping symbol  

• List separator - one character  

• Time style  

• Time separator  

• Short date style  

• Date separator  

NOTE: The decimal symbol and the digit grouping symbol cannot be the same character. Also, the 
time separator and the date separator cannot be the same character. 

Formatting the Time and Date 

Avoid changing the time style or short date style in regional settings to values that are outside of the 
standard styles provided. Changing these values to non-standard styles may result in improperly 
formatting times and dates in some parts of iFIX.  

iFIX supports the following short date formats, some of which may not be available in certain 
language versions of Windows: 

• dd/mm/yy, or dd/mm/yyyy  

• dd/yy/mm, or dd/yyyy/mm  

• mm/dd/yy, or mm/dd/yyyy  

• mm/yy/dd, or mm/yyyy/dd  

• yy/dd/mm, or yyyy/dd/mm  

• yy/mm/dd, or yyyy/mm/dd  

Formatting the Regional Language Setting 

Avoid changing the language setting once a timer has been used in a schedule. If changed, the date 
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always reverts to 30/12/99, regardless of what you set the start time to be.  

Setting the System Default Locale 

The selected locale must be set as the system default.  

Video Drivers 

After much testing, GE Fanuc has found that some video drivers have unique problems that are 
apparent only when using these drivers. Additionally, GE Fanuc has found that many problems with 
video drivers occur in both iFIX applications and common applications, such as Excel and Word. 

If you are experiencing problems with your video driver, try using it in a different mode to find out if 
the problem is unique to a specific configuration.  

Using Third-party Video Drivers 

If you need to use a third-party driver, please use the following guidelines to resolve any problems you 
may experience: 

• Contact the manufacturer to ensure you have the latest version of the video driver. GE Fanuc 
has found that the latest version of third-party video drivers can fix some problems.  

• If the latest version of the video driver does not fix the problem, notify the video driver 
manufacturer to see if they are aware of the problem.  

• If all else fails to resolve the problem, contact GE Fanuc Technical Support.  

Optimizing Virtual Memory 

Through the use of paging files, Windows allocates space on your hard drive for use as if it were 
actually memory. This space is known as virtual memory. The following steps describe how to 
optimize virtual memory in Windows to achieve maximum performance from iFIX. 

To optimize the virtual memory paging file for iFIX in Windows:  

1. From the Windows Control Panel, open the System Properties dialog box: 

• In Windows Vista, click the System and Maintenance link, the System link, and then, in the 
Task list, click the Advanced System Settings link.   

• In all other versions of Windows, in the Control Panel, open the System item.  

2. Open the Performance Options: 

• In Windows Vista, in the System Properties dialog box, click the Advanced tab, and in 
the Performance Options area, click Settings. The Performance Options dialog box 
appear. 

• In Windows XP, in the System Properties dialog box, click the Advanced tab, then in the 
Performance group box, select Settings. In the Performance Options dialog box, click the 
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Advanced Tab. 

• In Windows Server 2003, in the System Properties dialog box, click the Advanced tab, 
then select Performance Options. 

3. In the Virtual Memory group box, select Change.  

4. In the Initial Size field, enter a value equal to three times your physical memory.  

5. In the Maximum Size field, enter a value equal to three times your physical memory.  

6. Select Set.  

7. Click OK to save the changes and exit the dialog box.  

NOTE: If the paging file is set to grow dynamically, your system may experience severe 
performance problems during runtime. To ensure optimal performance, be sure that the 
Initial Size and Maximum Size of the paging file are the same so that the paging file does not 
grow dynamically. 

Running iFIX as a Service 

If you are running iFIX as a service, please take note of the following information. 

Windows Services 

In the Windows Services control panel, do not stop the iFIX service or make changes to the iFIX 
configuration. This applies to iFIX running on any operating system. 

Enabling iFIX to Run as a Service 

To enable iFIX to run as a service:  

1. Shut down iFIX. 

2. Ensure that you are logged in as a user in the Administrators group. If not, log in as an 
Administrator now. 

3. On the Start menu, point to Programs, Proficy HMI SCADA - iFIX, and then System 
Configuration. The System Configuration Utility (SCU) window appears. 

4. On the Configure menu, click Local Startup. The Local Startup Definition dialog box appears.  

5. In the Service area, select the Continue running after logoff check box, as illustrated in the 
following figure. This configures iFIX to run as a service when you start iFIX. 
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NOTE: The check boxes in the Service area of this dialog box are unavailable while iFIX is 
running. You need to shut down iFIX, as you did in step 1, to update them.  

6. Additionally, if you want to start iFIX whenever you start Windows, select the Start iFIX at 
system boot check box.   

The Start iFIX at system boot option is available only when the Continue running after Logoff 
option is selected. 

7. Click OK.  

8. Exit the SCU.  

9. Restart iFIX.  

Disabling iFIX as a Service 

To disable iFIX from running as a service:  

1. Shut down iFIX. 

2. Ensure that you are logged in as a user in the Administrators group. If not, log in as an 
Administrator now. 

3. On the Start menu, point to Programs, Proficy HMI SCADA - iFIX, and then System 
Configuration. The System Configuration Utility (SCU) window appears. 

4. On the Configure menu, click Local Startup. The Local Startup Definition dialog box appears.  

5. In the Service area of dialog box, clear the Continue running after logoff check box.  

6. Click OK.  

7. On the File menu, click Save to save the SCU file. 

8. Exit the SCU.  
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9. Restart iFIX.  

iFIX Paths 

Windows does not map network drives until a user logs in. Therefore, if you are running iFIX as a 
service under Windows, all iFIX paths must be set to a local drive.  

Required Application Feature 

You must assign the Enable Ctrl+Alt+Del application feature to the user that is logged in when iFIX is 
running as a service. Otherwise if a user logs out of the operating system while iFIX is running as a 
service, no one will be able to log back in to the operating system. 

Running iFIX with Terminal Services 

You must configure the Default Service SCU in the Startup Profile Manager if you want to run iFIX as 
a service on the Terminal Server. For more information, refer to the Configuring the Default Profile 
section in the Using Terminal Server electronic book. 

Starting the Proficy iFIX WorkSpace 

You should not have the WORKSPACE.EXE file listed as a configured task in the Task Configuration 
dialog box of the SCU. Instead, you should start the Proficy iFIX WorkSpace from the Startup group 
for the user, or have the user start the Proficy iFIX WorkSpace manually. 

NOTE: If you do configure iFIX to run as a service, and the WORKSPACE.EXE is listed as a 
configured task in the Task Configuration dialog box of the SCU, make sure you configure 
WORKSPACE.EXE to run as a foreground task.  To do this, on the SCU's Configure menu, click Task 
List. Select the WORKSPACE.EXE task, and in the Startup Mode area click Normal. 

Running iFIX with Other Programs 

By default, iFIX uses the local System account when running as a service. However, you cannot use 
the System account with certain applications, such as the Proficy Historian.  

To configure a different user account for iFIX running as a service:  

1. From Control Panel, open the Administrative Tools, then Services.  

2. In the Services folder, right-click Proficy HMI/SCADA iFIX server and select Properties.  

3. In the Log On tab, set the user name and password for This Account to the user account you 
want to log in when iFIX is running as a service.  

Fast User Switching Not Supported 

Fast user switching is not supported with iFIX, even if you are running iFIX as a service. 

Running the OPC Client Driver and iFIX as a Service 

If you want to run the OPC Client driver as a service, iFIX must also run as a service. Likewise, if you 
want to run iFIX as a service, the OPC Client driver must run as a service. You cannot run one as a 
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service, without the other also running as a service.  

OPC Certification 
Based on Microsoft's OLE (Object Linking and Embedding) technology, OPC (OLE for Process 
Control) provides greater interoperability between control applications, field systems and devices, and 
front office/backoffice applications. OPC servers, such as DCSs, PLCs, smart field devices, and 
analyzers provide real-time information and can communicate directly with the Proficy HMI/SCADA - 
iFIX product. 

The iFIX 5.0 product is an OPC 2.05a DA enabled client, which lets iFIX retrieve data from any OPC 
1.x or 2.x (up to version 2.05a) compliant data server. To access local or remote data from a third party 
OPC Server, use the iFIX OPC Client version 7.4x, which is also in included with iFIX. 

iFIX also has an iFIX OPC Server (OPC20iFIX.exe) that serves out data via OPC from the iFIX 
Database.  

Be aware that Proficy iFIX currently includes two OPC servers: 

• OPC20iFIX.exe (Intellution.OPCiFIX) – an OPC 2.05a (out of process) Data Server 

• iFixOPCAESrv.exe –  an OPC 1.10 Alarm and Events (A&E) Server 

Both OPC Servers included with iFIX are in compliance with the OPC Foundation’s "Self Tested" 
specifications. GE Fanuc ran a series of OPC tests to verify compliance for the versions listed above. 

You can find more information about OPC on GE Fanuc's Support web site at: 
http://support.gefanuc.com. 

Installing the iFIX Software 
The steps that follow outline how to install the iFIX software from the product install DVD. 

To install iFIX software:  

1. Log in to Windows with Administrator privileges. Ensure that there are no iFIX, FIX, or GE 
Fanuc processes running, and close any other programs that are running.  

NOTE: If you plan to use the integrated Proficy Historian features in iFIX, you must shut 
down Historian services and licensing prior to installing iFIX and Historian.  

2. Insert the iFIX DVD into your DVD drive. The iFIX installation screen appears. 

NOTE: If this screen does not automatically appear, double-click the InstallFrontEnd.exe file 
on the DVD to display it. A message may appear with a security warning, click Run to 
proceed. 

3. Click the "Install iFIX" link. A message box appears asking you to confirm the install.  

4. Click Yes to proceed. The install program starts and the Welcome screen appears.  

5. Click Next to continue. The license agreement screen appears.  
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6. Click "I accept the terms of the license agreement" if you want to continue, and then click 
Next.  

IMPORTANT: If a previous version of iFIX is detected, you can choose to upgrade iFIX. For 
iFIX versions before 4.0, you have the choice to upgrade or install iFIX to a completely new 
folder, without upgrading. If you want to upgrade, it is suggested that you do so using the 
install at this point in time.  

The Setup Type screen appears. 

7. Select an option and click Next: 

• Complete – Installs all iFIX components, including options such as FIX Desktop, the Sample 
System, the Electronic books (e-books), and the My-T-Soft virtual (on screen) keyboard. 

• Custom – Installs iFIX and the options that you choose. You are prompted to enter your 
options after you select an install path. 

• Typical – Installs iFIX, the Electronic books (e-books), the Sample System, and the My-T-
Soft virtual (on screen) keyboard. FIX Desktop is not installed with this option. 

The Choose Destination Location screen appears.  

8. Leave the default C:\Program Files\GE Fanuc\Proficy iFIX path or click Browse to select a 
folder.  

NOTES:  

• If you are upgrading from FIX32, make sure that you choose a location other than the 
folder that contains your FIX32 software, if it is installed on the same computer. Do 
not install over a current FIX32 installation.  

• If you enter a custom install path, be aware that the path can be no greater than 100 
characters long. 

• If you want to use 6.x drivers, the iFIX compressed install path must be no greater 
than 64 characters long. iFIX uses the Microsoft compression algorithm to try to fit 
longer paths within this boundary. Some paths are not compressible to the 64 
character maximum length. Please be aware of this. In addition, make sure that the 
registry key, 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\FileSystem\NtfsDisabl
e8dot3NameCreation, is not enabled (is set to 0) when the install folder is created. 
When set to 1, the compression algorithm is disabled. Refer to Microsoft help for more 
information on the GetShortPathName() compression algorithm. 

• After installing a 6x driver, the driver is listed in the SCU in the Drivers Available 
dialog box (which can be accessed from the I/O Driver Name browse button in the 
SCADA Configuration dialog box). You need to manually add the driver to the 
Configured I/O Drivers list in the SCADA Configuration dialog box. 

9. Click Next to continue.  

NOTE: If you selected a Custom install, instead of Complete, the Select Features screen 
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appears. Select the features you want to install, and click Next. 

The Ready to Install Program screen appears. 

10. Click Install. The progress of the installation displays on screen as the files are copied. After a 
few minutes, when the install finishes copying the files, the Proficy iFIX Configure Wizard 
dialog box appears.  

11. Enter the Node Name, Node Type, and Connectivity Type, if applicable, and then click OK. 
A message box appears, notifying you that either Proficy Historian is already installed or that 
is going to be installed.  

12. Click OK. If you chose to install Proficy Historian, the Historian installation screen appears. 
Otherwise, proceed to step 15. 

13. If you do not want to install Historian click Cancel and skip to step 15. Otherwise, go to step 
14. 

NOTE: If you choose not to install Historian, the following features will not work: 

• iFIX database tags from Database Manager will not automatically be added, updated, 
or deleted to or from Historian. 

• You will not be able to update the Proficy Historian tab of Database Manager blocks. 

• Imported or exported database tags will have default values in the Historian field, but 
will not be used. 

• The FixtoHIst.exe and Historical Datalink features will be installed, but will not work 
without Proficy Historian. 

14. Install Historian. To do so: 

a. Click Next. The Select Components screen appears. 

b. Choose the components you want to install and click Next. The Windows Firewall 
screen appears. 

NOTE: If you only want to install collectors on this node, do not install the 
Historian server; clear the Server check box. 

c. Select Yes and click Next. The Select OPC Servers screen appears. 

d. Select the OPC Servers you want to use and click Next. The Choose the Program 
Folder screen appears. 

e. Leave the default path or click Browse to select a folder, and then click Next. The 
Choose the Archive Folder screen appears. 

f. Leave the default path or click Browse to select a folder, and then click Next. The 
Configuration Review screen appears. 

g. Click Next. The progress of the installation displays on screen as the files are copied. 
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The Setup Complete screen appears. 

h. Click Finish. A message box appears reminding you to manually install the Historian 
Service Pack 1 and SIM, located on the installation DVD, after iFIX installation 
completes. 

i. Click OK. 

15. When a message box appears requesting that you view the release notes, click Yes. Close the 
release notes after you finish reviewing them to resume the install. The Setup Complete 
screen appears.  

16. Click Finish.  

17. After the install completes:  

• If you have a new key, power off the computer and insert your USB or parallel port key 
into the appropriate port.  

• If you have an older key that you are updating, use the update file and follow the 
instructions from GE Fanuc to update your key.  

18. Restart the computer. As the computer restarts, log in to Windows with the same user name 
(with Administrator rights).  

IMPORTANT: If upgrading from FIX v7 to iFIX with FIX Desktop, do not start iFIX yet. 
Refer to the Overview of Steps to Upgrade from FIX 7.x section for information on how to 
proceed. 

19. If you installed Historian, proceed to install the required Historian Service Pack and SIM. The 
SIM provides you with the new verison of the Historian toolbar that includes the Configure 
Historian Server button and the new  VisconX button. 

Using iFIX with Proficy Historian 
Beginning with iFIX 5.0, you can easily configure Proficy Historian to be your historian. The 
application is integrated with iFIX, which means that after configuring the Proficy Historian, you can 
perform the following tasks in iFIX: 

• Set Proficy Historian tags for collection for the iFIX database. 

• Insert a Historical Data Link into your picture in the iFIX WorkSpace. 

• Use VisiconX data and grid objects to access Proficy Historian data from the iFIX 
WorkSpace. 

Although Proficy Historian is integrated with iFIX, you do not have to use Historian in the iFIX 
WorkSpace; you can choose to use Historian as a separate application. When making your decision on 
how you want to use Historian, keep the following considerations in mind. 
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Configuration Considerations 

Although many of the features of Proficy Historian can be configured in iFIX, some cannot. They must 
be configured directly in Historian. These features include: 

• Security 

• Alarms, if you are using them 

• Collection on any field other than F_CV 

• Archive compression 

• Archive back-up  

• Other tag properties not configurable in iFIX 

• Historian parameters for Database Dynamos, or loadable blocks 

• Redundancy 

Other Considerations 

Multiple Databases 

If you are using multiple databases, you may want to use Proficy Historian separately from iFIX. 
When used together, Historian does not recognize tags from the iFIX database with the same name as 
different tags, even though the source is different. So, tags that exist in your iFIX database are ignored. 
The data that is populated comes from Historian, not from the iFIX database. To avoid this problem, 
verify that each tag has a unique name. 

For example, you have a tag called AI1 in both Process Database 1 (PDB1) and Process Database 2 
(PDB2). Both tags are added to Historian as FIX.AI1.F_CV. If you reload PDB1 and then PDB2, the 
AI1 tag is overwritten in Historian. 

Collection Delay 

When iFIX and Historian are used as an integrated application, rather than as separate applications, it 
takes longer for tags to update if the Collector is running. Additions, deletions and modifications of 
tags may take twice as long to display – approximately two minutes, instead of one – than if each 
application was used separately. 

Collectors 

If you choose to use Historian, not all installed collectors will be available for selection as the default 
Collector. Because this feature only supports collectors that read data from iFIX, the collectors 
available for selection are limited to the following: 

• iFIX Native Collector 

• OPC Collector reading from Intellution.OPCEDA or Intellution.OPCiFIX OPC servers 
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Electronic Signatures 

If you use electronic signatures, then you should probably not use the integrated Historian feature. If a 
tag requires an electronic signature in Historian and does not in iFIX, and a user makes a change in 
iFIX, the user is not prompted for a password. Instead, the change is made, bypassing Historian's 
electronic signature requirement. 

Result of Not Installing Historian 

If you choose not to install Historian, the following features will not work: 

• iFIX database tags from Database Manager will not automatically be added, updated, or 
deleted to or from Historian, 

• users will not be able to update the Proficy Historian tab of Database Manager blocks, and 

• imported or exported database tags will have default values in the Historian field but will not 
be used. 

Choosing Not to Install Integrated Historian 

If you do not want to install integrated Historian, and continue using Historian as you did before, then 
never do the following: 

• select the Automatically Configure Tags for Collection in Historian on the Proficy Historian 
tab of the User Preferences dialog box. 

• use Proficy Historian fields in iFIX Database Manager to configure anything in Historian. 

Post-Installation Steps for Historian 

If you choose to install Historian, there are post-installation steps you will need to perform. For more 
information, see Configuring iFIX to Use Proficy Historian and Configuring Security When Using 
iFIX with Proficy Historian. 

Configuring Security When Using iFIX with Proficy Historian 

Beginning with iFIX 5.0, iFIX iFIX configures Historian by adding and deleting tags and changing tag 
properties. Therefore, applicable security measures must be configured. However, tag level security 
and Historian domain security cannot be done in the iFIX application; it must be done in Historian.  

For Historian domain security, see "User Privileges for Starting a Collector" in the Historian eBook.  

For all other security considerations for Historian, see the chapter "Implementing Historian Security" 
in the Historian eBook. 

Configuring iFIX to Use Proficy Historian  

The following table describes the process for configuring iFIX to run with Proficy Historian: 
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Configuration Process 

Stage Description 

1 If upgrading from a previous release of iFIX and you have Historian installed 
on the PC, shut down Historian services and licensing prior to installing iFIX 
and Historian. 

2 During the iFIX install, when prompted, choose to install Historian.  

3 Restart your computer and manually install SP1 for Proficy Historian, 
IH31_SP1.exe, and then restart the computer. 

4 Install the SIM provided on the IFIX 5.0 DVD for Proficy Historian, 
IH31_1462289414.exe, and then restart the computer. 

5 Start iFIX and the WorkSpace. 

6 Verify that Historian Server is set to Proficy Historian and not Classic 
Historian. Close and restart the Workspace.  

7 Configure the Historian Server. Use the Default iFIX collector to add tags 
automatically to Historian. 

8 In the iFIX Database Manager, add the blocks that you want to start collecting 
on. Use the Proficy Historian tab to enter the information from Historian. 
Save your database.  

9 After approximately two minutes, in the Historian Administrator, check that 
your tag was added. If your tag was not added or collected in Historian, check 
the log file confighist.txt in the iFIX\LOCAL directory. 

10 Verify configuration. Add a Historical datalink to your picture, switch to run 
mode, and view the last value collected in the datalink.  

Installing the FIX Desktop Software 
FIX Desktop is provided as a custom option in your iFIX product install.  To install FIX Desktop 
option when installing iFIX, select the Custom option and then select the FIX Desktop check box from 
the list of features. If you install iFIX without FIX Desktop, you can later install it by running the iFIX 
install program again. 
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NOTE: Be aware that the changes to support 15 digits of precision in iFIX 4.5 and greater are not 
supported in FIX Desktop applications, such as Draw and View. If you try to use this feature in FIX 
Desktop applications, you will get unexpected results. 

The steps that follow explain how to install the FIX Desktop software from the product install DVD, 
after you already installed iFIX. 

To install FIX Desktop software after installing iFIX:  

1. Ensure that there are no iFIX, FIX, or GE Fanuc processes running, and close any other 
programs that are running.  

2. Log in to Windows with Administrator privileges.  

3. Insert the iFIX DVD into your DVD-ROM drive. The iFIX installation screen appears. 

NOTE: If this screen does not automatically appear, double-click the InstallFrontEnd.exe file 
on the DVD to display it. 

4. Click the "Install iFIX" link. A message box appears asking you to confirm the install.  

5. Click Yes to continue. The install program starts and the Welcome screen appears.  

6. Click the Modify option, and then click Next to continue.  The Select Features screen appears. 

7. Select the FIX Desktop check box and click Next. The install begins. 

NOTE: FIX Desktop applications are installed into the iFIX product folder. If you installed 
iFIX to the default location, this folder is C:\Program Files\GE Fanuc\Proficy iFIX.  

1. When the install completes a Maintenance Complete message box appears. 

8. Click Finish.  

9. Restart your computer.  

IMPORTANT: If upgrading from FIX v7, do not start iFIX yet. Refer to the Overview of 
Steps to Upgrade from FIX 7.x section for information on how to proceed. 

Online Registration 
You can register iFIX online after you have installed the product. 

To register iFIX online:  

1. In Classic view, from the WorkSpace's Help menu, point to Proficy iFIX WorkSpace Help, 
and then GE Fanuc Automation On the Web, and click Register Online.  

-Or- 
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In Ribbon view, click the WorkSpace button, and then on the Application menu, click 
Options. On the Options dialog box, select Resources from the navigation plane, and then 
click Register. 

2. Enter the appropriate fields on the registration form, and click Next until all pages are 
completed.  

Additional Resources 
You can access many additional resources after you install your product. To do so, use one of the 
following procedures. 

NOTE: The following procedures apply only to Ribbon view. 

To access technical support online:  

1. Click the Application button and then on the Application menu, click Options. 

2. In the Navigation pane click Resources.  

3. Click Support. 

4. Click OK on the Resources page. 

To access GE Fanuc Intelligent Platforms online:  

1. Click the Application button and then on the Application menu, click Options.  

2. In the Navigation pane click Resources.  

3. Click Home Page.  

4. Click OK on the Resources page. 

To determine the software version number:  

1. Click the Application button and then on the Application menu, click Options. 

2. In the Navigation pane click Resources.  

3. Click About.  

4. Click OK. 

5. Click OK. 
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Using iFIX and FIX on the Same Computer 
Although you can run iFIX and FIX Desktop applications at the same time, you cannot run iFIX and 
FIX 7.0 at the same time on a single computer. You can have iFIX and FIX 7.0 installed on the same 
computer, however. The following sections address issues that occur when installing iFIX and FIX 7.0 
on the same computer. 

NOTE: Because the hardware key for iFIX with FIX Desktop is different from the FIX hardware key, 
remember to remove the iFIX hardware key and insert a FIX hardware key before installing or 
running FIX 7.0. 

General Notes on Installing FIX and iFIX on the Same Computer 

When installing FIX 7.0 on a computer that already has iFIX installed (or vice versa) do not elect to 
use the current SCU configuration when prompted during the install. If you select to use the current 
SCU, both FIX and iFIX will launch with errors when you try to run either program after the install.  

Installing iFIX on a FIX 7.0 Node 

If you install iFIX on a node that has FIX installed and you have at least one version 7.0 driver 
installed, the registry paths for FIX 7.0 are changed to iFIX paths. Therefore, when you run a FIX 7.0 
application, such as the System Configuration Utility, you will receive errors. 

To avoid these errors, install iFIX without I/O drivers. This preserves your FIX 7.0 paths in the 
registry. 

Uninstalling iFIX and FIX 7.0 

You can install iFIX and FIX 7.0 on the same computer. If you subsequently uninstall iFIX, you must 
re-install FIX 7.0.  

Starting up FIX 7.0 After Installing iFIX 

An application error occurs when you start up FIX 7.0 as a service under Windows after you install 
iFIX. The error occurs because both FIX 7.0 and iFIX 5.0 use the same key name (FIX) under the 
Services key in the registry. Therefore, when you install iFIX 5.0, it overwrites the entry for FIX 7.0. 

Each product needs to have its own Services key. FIX 7.0 runs correctly if it is not run as a service. 

The workaround for this problem is to edit the registry so that the Services key points to the service 
executable in the correct path. The key is located in 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Fix. Set the ImagePath value to the 
correct path for fixsrv.exe. 

Installing iFIX after Uninstalling iVisualize 
If you have uninstalled iVisualize®, you must modify the FixUserPreferences.ini file before installing 
iFIX 5.0. This file is located in the C:\Program Files\GE Fanuc\Proficy iFIX\Local folder. 

The section [AppConfigPicturePreferences] contains the following lines: 

TotalConfigPicturePath=1 
PicturePath#0=*C:\Program Files\GE Fanuc\Proficy iFIX\PDB\PanelStart.ivs 
Change TotalConfigPicturePath=1 to TotalConfigPicturePath=0 and delete the line that reads 
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PicturePath#0=*C:\Program Files\GE Fanuc\Proficy iFIX\PDB\PanelStart.ivs. 

You will then be able to install iFIX 5.0. 

Using iFIX with Microsoft Office 
You can use the Microsoft Office family of products and iFIX on the same computer. However, to 
ensure that VBA works correctly, install Microsoft Office products before installing iFIX.  

Use the following table as a guide for installing and removing either product.  

If you have... And you want to... Then... 

Installed iFIX Install Microsoft Office 
Products 

Remove iFIX, install Microsoft 
Office products, and re-install 
iFIX. 

Installed Microsoft Office 
Products 

Remove Microsoft 
Office Products 

Remove iFIX, remove Microsoft 
Office products, and re-install 
iFIX. 

Started the iFIX WorkSpace 
for the first time, and this 
message appears:  

Run time error "48": Error in 
loading dll. 

Use iFIX and 
Microsoft Office 
harmoniously  

Uninstall iFIX, uninstall Microsoft 
Office, re-install Microsoft Office, 
and re-install iFIX. 

Backup Files 
When you save one of the following files, iFIX creates a backup file: 

• *.PDB – backed up as *.^DB 

• *.SCU – backed up as *.^CU 

• Profiles.cfg – backed up as Profiles.cfg.^AK 

• DISPLAY.DOV – backed up as DISPLAY.^OV 

• NODENAME.DOV – backed up as NODENAME.^OV  

iFIX also creates these backup files after you start iFIX for the first time after an upgrade. These 
backup files are helpful in disaster recovery of the individual files.  

For new iFIX installs, be aware that you can also use the Factory Default Backup for disaster recovery 
– performing a clean restore of your entire iFIX system. A clean restore includes the files listed above 
along with other Factory Default files. For more information, refer to the Using and Creating Factory 
Default Files section in the Understanding iFIX electronic book. 
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For upgrades, be aware that you can perform a Custom Backup to backup the files listed above before 
the upgrade. After the upgrade, you can restore these files with the Backup and Restore wizard. Refer 
to the Overview of the Backup Process section in the Understanding iFIX electronic book for more 
information.  

IMPORTANT: Do not use a Full Backup from a previous release of iFIX to update the files in the 
currently installed iFIX folder. Issues can occur with upgrade paths, and possibly other files. 

Optionally, after you upgrade your system with the Custom Backup, you can create a new Factory 
Default Backup, that you can use for disaster recovery in replace of the original Factory Default 
Backup file. This information is described in the Using and Creating Factory Default Files and Sample 
BackupRestore.ini sections. 

Proficy Change Management and iFIX 
If you plan to use Proficy Change Management with iFIX, to help you manage your iFIX project files, 
and track changes to these files, install iFIX first. After you install iFIX, you can install Proficy 
Change Management 5.7 or 5.8.  

Additionally, you need to configure a few items on both iFIX and the Change Management Server, as 
described in the Setting up iFIX for Use with Change Management topic in the Change Management 
and iFIX e-book. 

NOTE: If you want to run iFIX with other Proficy products, such as Proficy Change Management, you 
will need to upgrade to an M4 key. For more information, refer to the The Hardware Key section. 

If you are upgrading an iFIX computer with the Proficy Change Management, upgrade to Proficy 
Change Management 5.7 or 5.8.  

Optional Hardware 
iFIX supports the following optional hardware. You may want to purchase one or more of these items 
to enhance your iFIX system. 

• A Microsoft-supported touch screen or other pointing device.  

• A DigiBoard™ to provide your computer with up to 9 serial ports. If you are using multiple 
I/O drivers or multiple ports for one I/O driver, you may require the use of a DigiBoard. GE 
Fanuc has tested and supports the Digichannel PC/8E.  

Uninstalling iFIX 
To uninstall iFIX, from the Control Panel, in the Add or Remove Programs dialog box, click the 
Remove button next to the "Proficy HMI SCADA - iFIX 5.0" entry. This action launches the install 
program allowing you to remove the iFIX product. 

If you want to uninstall other items that install along with iFIX, such as the iFIX OPC Client, M1 
Licensing, the Proficy Change Management Client API, M4 Common Licensing, Proficy Discovery 
and Auto-Assembly Component, you need to uninstall these items separately.  

IMPORTANT: For the Proficy Discovery and Auto-Assembly Component (DAC), it is recommended 
that you uninstall it before you uninstall the iFIX product. If you wait until after you uninstall iFIX, the 
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DAC uninstall will display error messages. 

Sleep or Hibernate Mode 
If your SCADA computer has been sleeping overnight, or in hibernate mode, be aware that you will 
need to acknowledge all of the queued "License Warning" messages.  
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Upgrading from an Earlier Version of iFIX 
This chapter contains information about issues concerning upgrading to iFIX 5.0. Issues specific to 
upgrading from iFIX 2.5 and earlier are clearly marked. 

The Database and the Upgrade 

Be aware that when you upgrade to iFIX 5.0, the file size of your process database file will increase.  

Also, when you upgrade your database, the high and low engineering units (EGU) fields are converted 
from single precision to double precision floats. What that means, is that the degree of accuracy (the 
Epsilon value) changes from  +/_0.00000012 to +/_0.00000000000000022. If you are using extreme 
ranges (very large or very low values) for your EGU limits, you may possibly experience issues after 
an upgrade. To resolve these issues, open the Database Manager, export your database and then re-
import it. This procedure resets the block values. 

DDA Drivers and the Upgrade 

If you are using DDA drivers, such as ROC, BR3 or MBR, you must reinstall them after upgrade. If 
the driver installation files are unavailable, you can use a copy of your existing FIX.INI file to compare 
to the one created after the upgrade. Then, copy the missing lines from your old FIX.INI file to your 
new FIX.INI file. 

Before You Upgrade 

Before you upgrade your version of iFIX make sure you: 

• If you are upgrading an iFIX computer with the Proficy Change Management, upgrade to 
Proficy Change Management 5.7 or 5.8.  

• Shut down the DEP (Data Execution Protection) feature. One way to do this is from the 
Control Panel, access the System Properties. Select the Advanced tab, and click the Settings 
button in the Performance area. On the Data Execution Protection tab, select the "Turn on 
DEP for essential Windows programs and services only" check box. 

• Shut down all Proficy applications. It is important that no Proficy products are running when 
you run the iFIX installation program. 

• Save copies of your existing .INI files with your application preferences and any custom files 
you create. Customized files, such as *Res.dll files, and some *.INI files may be overwritten 
during an upgrade. As such, you may need to integrate your custom changes into the newer 
versions of these files after you upgrade.  

• Back up your existing iFIX projects. This includes the files in your LOCAL, Config Files 
Backup, PIC, and PDB folders.  

• It is also recommended that you create a backup copy of your Alarm ODBC configuration 
file(s). 
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• Export a report of your system configuration (SCU), for reference. (In the SCU, on the File 
menu, click Report. Refer to the Generating a System Configuration Report section for 
detailed steps.) 

• Export a report of your security configuration, for reference. (In the Security Configuration 
application, on the File menu, click Export. Refer to the Exporting a Report of the Security 
Configuration section for detailed steps.) 

• If you have an application created by an Integration Toolkit, Database Dynamo Toolkit, or 
System Extension Toolkit from iFIX 2.5 or earlier, and you want to use this application with 
iFIX 5.0, do not uninstall iFIX. You must install iFIX 5.0 over your existing iFIX 
configuration. Your toolkit application will not run if you uninstall your previous version of 
iFIX. 

• Be sure to obtain any toolkit updates that you need, prior to installing iFIX. For instance, if 
you have previously installed the iFIX Productivity Pack for Allen Bradley, you must get the 
updated version prior to upgrading to iFIX 5.0.  

• If you plan to use Enhanced Failover feature provided in iFIX 5.0, review the Enhanced 
Failover and Upgrading section. 

Steps to Upgrade from an Earlier Version of iFIX 

To upgrade from earlier versions of iFIX 

1. Update your license and/or hardware key. For steps refer to the Upgrading the iFIX License 
section.  

2. Log in to Windows with Administrator privileges.  

3. Ensure that there are no iFIX, FIX, or GE Fanuc processes running, and close any other 
programs that are running.  

4. Insert the iFIX DVD into your DVD-ROM drive. The iFIX installation screen appears. 

NOTE: If this screen does not automatically appear, double-click the InstallFrontEnd.exe file 
on the DVD to display it. 

5. Click the "Install iFIX" link. A message box appears asking you to confirm the install.  

6. Click Yes to continue. The install program starts and the Welcome screen appears.  

7. Click Next to continue. The license agreement screen appears.  

8. Click "I accept the terms of the license agreement" if you want to continue, and then click 
Next.  

A message box appears indicating that a previous version of iFIX has been detected. 

9. Click Yes to upgrade.  
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CAUTION: If you select No to this message, you can no longer run the older version of iFIX. 
By default, iFIX installs to the C:\Program Files\GE Fanuc\Proficy iFIX folder instead. 
 THIS IS NO LONGER AN UPGRADE. Use caution in copying files from your previous iFIX 
release, into your new iFIX install folder.  

The Setup Type screen appears. 

10. Select Complete and then click Next. If you selected Custom instead, you will be prompted 
later to select your install features, such as iFIX with FIX Desktop. The Ready to Install 
Program screen appears. 

11. Click Install. The progress of the installation displays on screen as the files are copied. After a 
few moments, a message box appears asking if you would like to review the release notes. 

12. Click Yes to view the release notes. Close the release notes after you finish reviewing them to 
resume the install. The Setup Complete dialog box appears.  

13. Click Yes to restart your computer now, or No to do it later. 

14. Click Finish.  

NOTE: Be sure to restart your computer before starting iFIX. As the computer restarts, log in 
to Windows with the same user name (with Administrator rights).  

Upgrading the iFIX License 
The instructions for upgrading your iFIX license depend on the key you have and the enabled options 
you want. You may need to run an update program, or you may need to exchange your key for a newer 
one. iFIX 5.0 only supports HASP M1 or M4 keys. 

The version and type of key you have should appear imprinted on the outside of the key. If you do not 
know what type of key you have, check the label on the physical key. If you are still unsure whether 
you need to exchange your key for a new one, contact your iFIX sales representative.  

Upgrading from iFIX 2.6 or Later 

When you upgrade to iFIX 5.0 from iFIX 2.6 or later, you are required to update the license on each 
iFIX machine. If you have an M1 or M4 key, GE Fanuc provides utilities to help you perform this task.  

For an M1 key, use the iKeyUpdate application to update your license. For an M4 key (the newest 
key), use the Proficy License Viewer to update your license. To perform a key update: 

• For iKeyUpdate, you will need to obtain an iLicense update file with specific information 
about your key.  

• For the Proficy License Viewer, you will need to obtain a .plic update file with specific 
information about your key.  

For information about obtaining the iLicense or .plic file, contact your sales representative. You will 
receive the new licensing file by disk or by e-mail. 

If you have other new Proficy products installed you may be required to update to an M4 key. This 
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requires you to physically remove the M1 key and insert the new hardware key. You cannot use both 
an M1 and M4 key on the same computer. For steps on how to install a hardware key, refer to the 
Installing the Hardware Key section. 

If you receive the error message, "Workspace encountered a problem and needs to close. We are sorry 
for the inconvenience," while registering, it is probably because you have an unsupported key, such as 
the Rainbow SuperPro. If you have a Rainbow SuperPro (Sentinel) key, which was offered for iFIX 
2.6 (before 2002), this key must be exchanged for a newer key, if you want to upgrade to iFIX 5.0. 

To update the license with the iLicense file:  

1. Double-click on the iLicense filename. The iKeyUpdate dialog box opens.  

The full path to your iLicense file should appear in the Update File text box. If it doesn't 
appear, browse to it. 

2. Click Update Now to update your hardware key.  

3. Click OK to confirm that you want to update your key. A message appears telling you that the 
key was successfully updated.  

4. If you want, you can run iKeyDiag to review the update to your hardware key.  

NOTE: Do not install iFIX 5.0 if you do not have the iLicense file. iFIX 5.0 will function in 
demo mode only on a system that does not have an updated key. 

To update the license with the .plic file:  

1. Save the .plic file to a directory of your choice. 

2. Double-click the file. The Key Update utility appears. The full path to your .plic file should 
appear in the Update File text box. If it does not appear, browse to it. 

3. Click Update Now to update your hardware key. 

The utility validates your current license. If the validation is successful, the utility updates the 
license; if the validation is not successful, the upgrade is halted. 

Upgrading from iFIX 2.5 and Earlier 

When you upgrade to iFIX 5.0 from iFIX 2.5 and earlier, you are required to replace your existing 
hardware key and license with a new hardware key and license. You should return your old key to GE 
Fanuc. For information about obtaining a new hardware key and license, or returning your old key, 
contact your iFIX sales representative.  

For more information about the new hardware key, see The Hardware Key section of this manual. 

Preserving Settings when Upgrading 
When iFIX is installed, all previously existing configuration files in the iFIX Local folder, with the 
exception of the *Res.dll files, are backed up to the C:\Dynamics\Config Files Backup folder. To 
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preserve these settings, after the install, copy your customized changes from these backup files into 
each current file located in the Local folder. Do not copy and paste the entire file into the Local folder 
because it would overwrite any new settings installed with iFIX 5.0. 

Notes on Database Dynamos and Custom Programs that Run with iFIX 
Startup 

When you install the newest release of iFIX, the product install program places a new version of the 
startup control file, FIX.INI, into your iFIX Local directory. The previous version of this file is copied 
to the iFIX Config Files Backup folder, along with the other configuration files. 

If you configured Database Dynamos, also known as loadable blocks, or other custom programs to run 
as part of iFIX startup, you should compare the new FIX.INI file in the Local folder against the 
FIX.INI file stored in the Config Files Backup folder. If you find any changes between the two files, 
add the necessary lines to the new FIX.INI stored in the Local path. Do not copy the old FIX.INI over 
the new FIX.INI file. 

NOTE: Paths with embedded path spaces in the FIX.ini require quotes. For example:  
RUN="%E:\PROGRAM FILES\GE FANUC\PROFICY IFIX\SysAlertQMgr.exe" /F /NSysAlertViewer 

SCU Files and the Upgrade 
If a previous version of iFIX already resides on your computer when you try to install iFIX 5.0, a 
message box appears during the installation suggesting that you upgrade your existing iFIX install. It is 
recommended that you elect to upgrade iFIX when this message appears. By following the upgrade 
process, iFIX 5.0 installs to same folder where your previous version existed. For example, if you have 
iFIX 3.5 installed to the C:\Dynamics folder, when you upgrade, iFIX 5.0 installs to the C:\Dynamics 
folder. After the iFIX 5.0 install completes and you restart iFIX, your SCU file is upgraded 
automatically, and the original file is backed up with a .^CU extension.  

If you choose not to upgrade and install iFIX to another path, such as the default: C:\Program Files\GE 
Fanuc\Proficy iFIX, there are a few extra steps you need to perform before you can start the older 
version SCU file in iFIX 5.0. First, you must rename the older version SCU file, so that the name is 
different than the default iFIX 5.0 SCU file. For instance, if you try to start an iFIX 4.0 SCU file in 
iFIX 5.0 when the names of both SCU files are the same, an error message appears instead. So, be sure 
to rename your iFIX 4.0 SCU file to something other than the startup default file name before opening 
it in the iFIX 5.0 System Configuration Utility. After launching the SCU application, open the older 
SCU file. Now you can manually update the information in it, as described in the steps below.  

Be aware that if you have a Custom Backup available of your node with the previous version installed, 
you also can use that file to upgrade your SCU. During the restore, make sure you select the Use SCU 
File from Archive check box. If the SCU file name you are upgrading is the same as the iFIX 5.0 
default SCU file name, you need to change the path configuration at this point. Click on the View 
Project Path Configuration button to check the current paths. In the Project Path edit box, enter the 
iFIX 5.0 install path. This upgrades your SCU file automatically, however you still have to manually 
update other SCU information in the System Configuration Utility, as described in the steps below. For 
more information on the restore process, refer to the Overview of the Restore Process section. 

IMPORTANT:  

• You do not need to use a Full Backup from a previous release of iFIX if you are just 
upgrading the SCU file. Instead, use a Custom Backup. Make sure that you back up the SCU 
only in the .fbk file and restore it only in iFIX 5.0. If you do a Custom Backup, click “NO TO 
ALL” other files when restoring just the SCU file. Do not use a Full Backup between iFIX 
versions. Issues can occur with upgrade paths, and possibly other files. 
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• During a restore, use caution in restoring other configuration files. For instance, if you 
overwrite the .INI files in your iFIX Local folder, you lose all of iFIX 5.0 .INI settings. After 
that is done, there may be issues that cause iFIX or certain features not to work properly. For 
instance, if you overwrite the 5.0 FIX.ini file with a 3.5 one, you need to remove or comment 
out the RUN=REGISTERHELPFILES line in order to start iFIX 5.0 with this file.  

To update the SCU information manually: 

NOTE: The following steps describe how to modify an SCU file with a path outside the install 
path, so that you run it in iFIX. 

1. Shut down iFIX. 

2. On the Start menu, point to Programs, Proficy HMI SCADA - iFIX, and then System 
Configuration to open the SCU. 

3. From the SCU Configure menu, click Paths.  

4. In the Path Configuration dialog box, change the base path and NLS path to point to the local 
install path. Change the project path to point to the project destination folder, if it does not 
already do so. 

5. From the SCU Configure menu, click Tasks. 

6. In the Task Configuration dialog box, change the path of the configured tasks to the local 
install path, make sure that you include the same command line options. 

7. From the SCU Configure menu, click Network.  

8. In the Network Configuration dialog box, confirm the information is correct and make 
changes if necessary. 

9. From the SCU Configure menu, click SQL, and then click Configure SQL Tasks.  

10. In the SQL Task Configuration dialog box, make sure that the Primary and Backup paths are 
correct, if used. 

11. From the SCU Configure menu, click Local Startup Paths.  

12. In the Local Startup Definition dialog box, change the path to the folder you copied the 
project to with the get command.  

13. From the SCU File menu, click Save. Save it as the default startup SCU file name or indicate 
that this is the SCU you want to use on startup. 

14. Restart iFIX. 
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Enhanced Failover and Upgrading 
If upgrading from a previous version of iFIX with failover enabled, and you want to use the Enhanced 
Failover feature in iFIX 5.0, be aware that: 

• The Enhanced Failover feature is a keyed option in iFIX 5.0. You must purchase the 
additional Enhanced Failover option (SCADA Failover) if you plan to use SCADA Failover 
in iFIX 5.0. If you had purchased the Ack Failover option in your previous version of iFIX, 
your key upgrade will include the new SCADA Failover option.  

• If you purchased the Failover feature when you bought a previous version of iFIX, then your 
iFIX 5.0.plic license file update will enable the Enhanced Failover option automatically. Be 
aware, when you use the Proficy License Viewer in iFIX 5.0, that the part description 
changed from "ACK Failover" to "SCADA Failover."  

• Before installing iFIX, it is recommended that you confirm that the SCADA Failover option is 
enabled on your key. iFIX 5.0 software checks the Enhanced Failover option at startup. 
Without this option enabled, the Enhanced Failover functionality will not work. An error 
message appears if you try to run iFIX with the SCADA Failover feature.  

• If your 5.0 SCADA key does not show the SCADA Failover functionality enabled, and you 
purchased this additional option, please contact you sales representative before upgrading.  

• When you upgrade your iFIX SCADA node to iFIX 5.0, you will need to make configuration 
changes on your iFIX 5.0 SCADA nodes for the Enhanced Failover feature to work properly. 
For example, the Data Sync Transport dialog box in the System Configuration Utility (SCU) 
is new in iFIX 5.0. It requires that you enter the partner's IP address on both the primary and 
secondary SCADA nodes.  

• You can choose to upgrade your iClent (View) nodes with Failover enabled to iFIX 5.0, or to 
continue using your iClent (View) nodes with Failover enabled from any previous version of 
iFIX. There are no additional steps to configure the Enhanced Failover feature on the iClients 
if you already configured them in previous releases.  

• The Alarm Acknowledgement synchronization feature from previous iFIX versions is NOT 
supported on SCADA nodes upgraded to  5.0. The Alarm Acknowledgement functionality is 
replaced by the database synchronization and alarm area files provided in iFIX 5.0. 

• It is strongly recommended that you use a dedicated network between the primary and 
secondary SCADA nodes for dedicated SCADA-to-SCADA traffic. If the SCADA nodes are 
physically close to each other, then a crossover cable can be used.  

• It is strongly recommended that the network components (LAN adapters, hubs, switches, 
cables, etc.) used for SCADA-to-SCADA connection of the SCADA pair support a minimum 
1 Gigabit Ethernet. This allows for a higher rate of speed for data transfer between the 
primary and secondary SCADA nodes.  

• In iFIX 5.0, you will need to configure a primary and a "secondary" SCADA node. One 
SCADA will be in Active mode (processing data and alarms) while the other will be in 
Standby mode. This is unlike previous versions of iFIX, where you configured a primary and 
"backup" SCADA node and both nodes were processing data and alarms. The concept of the 
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SCADA pair still exists in iFIX 5.0, but GE Fanuc does not support using your standby 
SCADA as a development machine in iFIX 5.0 (for example, for database or picture 
development). However, there is a maintenance mode that allows you to upgrade your 
SCADA configuration without requiring a SAC restart.  

• Stratus solutions will continue to be supported in iFIX 5.0. Any Stratus SCADA nodes that 
you want to upgrade to use Enhanced Failover will require configuration changes on your 
iFIX 5.0 SCADA nodes for the Enhanced Failover feature to work properly (the same 
configuration changes as the non-Stratus nodes).  

• Custom applications or scripts that were written to synchronize databases or alarms on 
previous versions of iFIX will no longer be required with Enhanced Failover enabled. So as 
not to interfere with the 5.0 SCADA failover, you should remove these custom applications or 
scripts from your failover configuration.  

The following steps describe how to upgrade your failover system. 

To configure your iFIX SCADA nodes after an upgrade, if failover was used in a previous 
release: 

1. On the primary SCADA node, on the Start menu, point to Programs, then Proficy 
HMI/SCADA - iFIX, and then System Configuration. The System Configuration Utility 
(SCU) appears.  

2. On the Configure menu, click SCADA. The SCADA Configuration dialog box appears.  

3. In the Failover area, select the Enable check box if it is not already selected.  

4. In the Node area, verify or select the node type: Primary or Secondary.  

5. In the SCADA Name field, verify or enter the name of your partner SCADA node.  

6. Click the Data Sync Transport button. The Data Sync Transport dialog box appears.  

7. From the Description list, select the LAN adapter(s) to use for data synchronization between 
the SCADA pair, then select the Enable check box. Make sure that the LAN adapters you will 
not be using for data synchronization are not enabled.  

8. In the Partner's Address field, enter the IP address of the partner node.  

9. Use the default settings for the rest of the fields.  

NOTE: The Bandwidth Limit field in the Data Sync Transport dialog box allows you to enter a 
value to throttle down or limit the synchronization rate or bandwidth used. It is recommended 
when using a corporate, non-dedicated or shared network (10/100 or 1GB), that you "throttle" 
network traffic to limit bandwidth that the data synchronization process will consume.  

10. Click OK. 

11. Repeat steps 1-10 on the secondary SCADA node. 
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Title Bar in iFIX WorkSpace 
iFIX 3.0 and later provides a new title bar in the WorkSpace, which reads "Proficy iFIX WorkSpace." 
If you have any custom applications that use the FindWindow Microsoft API call, you will need to 
update these applications to reflect the new title bar. 

Programs that Run as a Service with iFIX 
When you start iFIX as a service, programs in the startup task list also start as services. If you upgrade 
from a previous version of iFIX, be aware that programs listed in the SCU's Task Configuration dialog 
box will continue to run as services if iFIX remains running as a service.  

However, if you previously started the iFIX OPC A&E Server with this command: 

iFixOPCAESrv.exe -service 

The -service option is no longer needed to run the iFIX OPC A&E Server as a service. You should go 
into the Task Configuration dialog box and remove the -service command from the startup task list.  

Be aware that you can only run programs such as the iFIX OPC A&E Server as a service if iFIX is 
configured to run as a service.  

If you want to run the OPC Client driver as a service, iFIX must also run as a service. Likewise, if you 
want to run iFIX as a service, the OPC Client driver must run as a service. You cannot run one as a 
service, without the other also running as a service.  

Toolbars 
If your Proficy iFIX WorkSpace contains additional standard toolbars from other iFIX versions, such 
as the Proficy Historian toolbar, these toolbars will appear in the iFIX WorkSpace system tree, in the 
Project Toolbar Files > Toolbars folder. Double-click a toolbar to display it in the WorkSpace. 

Standard vs. Classic Window Styles 
Because the standard window styles now include larger title bars and menu bars, such as those in 
Windows XP, scroll bars may appear in iFIX pictures (that you created in earlier versions of Windows) 
when you open them.  

To resolve this issue, GE Fanuc recommends that you change the Appearance Scheme in the Windows 
Display Properties dialog box to Windows Classic. 

Changing Permissions for PlugAndSolve and User Globals 
If you upgrade from iFIX 2.6, you may need to change the security properties of the user.fxg and 
plugandsolve.fxg files. To change the permissions on these files, you must be logged in as an 
Administrator. Use the following steps. 

To change permissions on a file: 

1. Open the File Explorer. 
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2. Right-click the PlugandSolve.fxg or user.fxg file in your iFIX PIC folder, and select 
Properties. The Properties dialog box appears. 

NOTE: If the Security tab does not appear in Windows XP, open Windows Explorer. From 
the Tools menu, choose Folder Options. The Folder Options dialog box appears. Click the 
View tab. Clear the Use simple file sharing (Recommended) check box and click OK. 

3. Select the Security tab. 

4. Click the Advanced button. The Advanced Security Settings for file name dialog box appears, 
where file name refers to the name of the file you selected in step 2. 

5. On the Permissions tab, for the specified user, check the Inherit from parent the permission 
entries that apply to child objects. Include these with entries explicitly defined here. 

6. Repeat steps 1-5 for the other file. 

Advanced Historian Not Supported 
Advanced Historian is not supported in iFIX 2.6 and greater. So, you cannot use Advanced Historian 
with iFIX 5.0. If you have Advanced Historian installed, contact your local iFIX sales representative 
about upgrading to Proficy Historian, GE Fanuc's historian product. 

Proficy Historian 
Beginning with iFIX 5.0, Proficy Historian is integrated with iFIX. However, using Historian in an 
integrated manner is entirely optional. Historian can still be used as a stand-alone application. If you 
choose to use Historian as a stand-alone product, its functionality is not impaired; it continues to work 
the same way as it did before your upgrade. To help you decide whether or not to use Historian as an 
integrated component of iFIX, see Using iFIX with Proficy Historian. 

If you decide to install the integrated Proficy Historian features in iFIX at a later date, all of the 
integration features, including the Historian toolbar, will be installed.  

If you decide to use the integrated Proficy Historian features in iFIX, you must shut down Historian 
services and licensing prior to installing iFIX and Historian and you must choose to install Historian 
during the iFIX install.  

After the iFIX database is upgraded, all newly added block fields for Historian are added with default 
values. 

Compatibility of iFIX 5.0 Pictures 
iFIX 5.0 supports pictures created, saved, or built in previous versions of iFIX. However, pictures 
created, saved, or built in iFIX 5.0 are not compatible and cannot be opened in older versions of iFIX. 

Resolving iFIX Displays 

When you upgrade your iFIX system, or add or delete tags from your database, it is important that you 
run resolve on all pictures and schedules. This will ensure that you are getting maximum performance 
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from your iFIX system. 

Converting Pictures from FIX 7.x to iFIX 

When converting pictures from FIX v7 to iFIX, we recommend that you load the corresponding 
database in Database Manager before converting a picture. If you do not load the current database, you 
will need to manually reset each animation. For more information, see the Using the Picture Converter 
Utility section of the Creating Pictures manual. 

Running Pictures Created in an Older Version of iFIX 

If you performed your original picture development on an earlier version of iFIX and have not 
upgraded to iFIX 2.2 or later, you may experience color mapping errors when upgrading to iFIX 5.0. 

To avoid color mapping problems, perform the following steps before saving and resolving any 
pictures in iFIX 5.0. 

To avoid color mapping problems:  

1. Copy and save the tables.lst file from the older version of iFIX.  

2. Install the iFIX upgrade or switch to the upgraded machine.  

3. Shut down the WorkSpace.  

4. Delete the tableconversion.lst file from the iFIX directory (C:\Program Files\GE 
Fanuc\Proficy iFIX).  

5. Copy the original tables.lst file to the iFIX directory.  

6. Restart the WorkSpace.  

Using Code Written for Pictures in iFIX 2.1 

Code written to position or size a picture using the ActiveWindow object in iFIX 2.1 may produce 
different results in an iFIX 5.0 system using multiple monitors with autoscale disabled. The incorrect 
positioning and sizing occurs because the ActiveWindow object in 2.1 does not account for the 
disabled autoscale in 5.0.  

You can access the ActiveWindow object directly from the documents collection or by calling the 
OpenPicture subroutine.  

To correct the sizing and positioning, multiply the parameters in the 2.1 script by the number of 
monitors.  

For example:  

In iFIX 2.1, you opened a picture on the second monitor of a dual monitor system by issuing the 
following command:  

openpicture "picture.grf",,0,50 

In iFIX 2.6 and later, open a picture on the second monitor of a dual monitor system by issuing the 
following command: 
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openpicture "picture.grf",,0,100 

Database Dynamos 
Database Dynamos, also known as loadable blocks, will require updates to work with iFIX 5.0. If you 
have old Database Dynamos on your system, the iFIX install program will detect them, and generate a 
warning message. This includes any Database Dynamos that you downloaded from the GE Fanuc web 
site, or installed from the Allen-Bradley Productivity Pack CD before you installed iFIX 3.x. 

The GE Fanuc web site contains updated versions of the database dynamos supplied by GE Fanuc. To 
obtain updated version of other dynamos, contact the vendor of that dynamo. To obtain the current 
version of the Database Dynamo Toolkit, contact your local iFIX sales representative. 

iFIX Dynamo Sets 
When you upgrade iFIX, or install a Software Improvement Module (SIM) that updates any iFIX 
Dynamo sets, the newer Dynamo sets overwrite the older ones. To avoid losing any modifications 
made to the older files, you can rename them or move them to a folder located outside the iFIX picture 
path. Dynamo set files have an .fds extension and are located in the C:\Program Files\GE 
Fanuc\Proficy iFIX\PIC folder, by default. 

Be aware that when you upgrade iFIX, the Dynamos in pre-built Dynamo sets and the Dynamos 
created before iFIX 4.5 are not considered Dynamo objects. This means you cannot use the Quick 
Dynamo Updater, the Dynamo Updater Wizard, and the Cross Reference Tool (available in iFIX 4.5 
and greater) to update instances of these Dynamos within existing pictures. Only Dynamo objects 
created in the newer version of iFIX can be updated with these tools. 

Pre-built Dynamos include the following Dynamo sets: 

• Historical.fds 

• Miscellaneous.fds 

• Motors.fds 

• Pipes.fds 

• PipesAnim.fds 

• Pumps.fds 

• PumpsAnim.fds 

• Tanks.fds 

• TanksAnim1.fds 

• TanksAnim2.fds 

• Valves.fds 
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• ValvesAnim.fds 

Deleting Temp Directory Contents if iFIX Installation Fails 
When upgrading to iFIX, in some cases the installation will run too quickly, taking only a few seconds, 
or hang and not complete the process. In both cases, the product will not successfully install.  

If this happens, delete the contents of the Temp directory and run the installation again. 

Alarm Summary Objects and Picture Translation 
For each picture created in a previous release that uses the picture translation feature and includes an 
Alarm Summary object(s), you must export the language file again after you upgrade. This step 
updates your language files to include the Alarm Summary object information.  

Next, using a text editor, you must provide translations for each of these new fields in the exported 
language (.csv) file(s). This step is required because the iFIX language translation file originally did 
not include the Alarm Summary object.  

NOTES:  

• iFIX 5.0 supports translation of the Alarm Summary object information through the picture 
object, or through the Alarm Summary object. You may also want to create new pictures 
which take advantage of the SwitchLanguage Method on the Alarm Summary object itself. 
 For more information on how to use this feature, refer to the SwitchLanguage Method 
Example in the iFIX Automation Reference.   

• In iFIX 5.0, you can also change the font of the Column Headers and the Status Bar in the 
Alarm Summary object for translation display purposes. This Font changing feature is new in 
iFIX 5.0 and can be accessed from the General tab of the Alarm Summary object in configure 
mode. You may want to update your pictures to use this feature, as well. For more 
information on how to use this feature, refer to the Configuring Fonts for the Column 
Headings and Status Bar in the Creating Pictures electronic book.   

To export a single language file: 

1. In the WorkSpace configuration mode, open the picture you want to export a language file 
for. 

2. In Classic view, on the WorkSpace menu, click User Preferences.  

-Or- 

In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User 
Preferences. 

3. Click the Picture Preferences tab and make sure the Translate Picture On Open check box is 
cleared. If it is selected, the LanguageDesired and TranslateOnOpen properties in the 
Properties window cannot be changed.  

4. Click OK to close the User Preferences dialog box. 
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5. Right-click in the picture and choose Property Window.  

6. From the LanguageDesired list, select the appropriate language. 

7. From the TranslateOnOpen list, select Yes. 

8. On the Translation toolbar, click the Export language file button. A message appears letting 
you know the language file was successfully exported.  

9. You can now open the language file in a text editor and translate the text strings for the 
picture. 

To export multiple language files: 

1. In the iFIX WorkSpace, on the Translation toolbar, click the Export multiple language files 
button. The Language File Exporter dialog box appears.  

2. In the Select pictures list, select the check box for each picture you want to export a language 
file for. 

3. If applicable, select the Show Tag Status pictures check box to display and select tag status 
pictures in the Select pictures list. 

4. If applicable, select the Always overwrite existing export files check box. If you are exporting 
a language file for a picture that already has a language file for the selected language, the 
existing language file will be automatically overwritten. If you clear this check box, you will 
be prompted to replace the existing language file. Click Yes to replace it and No to keep it. 

5. From the Select language list, choose the language that you want to provide translations for. 

6. Click Export. A separate language file is created for each picture you selected. 

7. You can now open each language file in a text editor and translate the text strings for the 
pictures. 
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Upgrading from FIX 7.x 
If you want to upgrade from FIX 7.x to iFIX 5.0, but continue to use your FIX 7.x pictures, you must 
install iFIX with the FIX Desktop option. FIX Desktop is provided as a custom option in your iFIX 
product install.  To install FIX Desktop option when installing iFIX, select the Custom install option, 
and then select the FIX Desktop check box from the list of features. 

After you upgrade to iFIX with FIX Desktop, you can run FIX Desktop Draw, View, and HTD 
applications alongside the Proficy iFIX WorkSpace. All applications use the iFIX security, database, 
and system configuration information.  

This chapter describes how to upgrade the FIX 7.x product to iFIX 5.0 with FIX Desktop. After you 
upgrade, you can continue to use your FIX32 pictures in FIX Desktop Draw and View applications, or 
you can migrate and create new pictures in the Proficy iFIX WorkSpace. 

Before you upgrade, you need to follow the steps outlined in the Preparing for the Upgrade to iFIX 
with FIX Desktop section. The actual upgrade steps are outlined in the Overview of Steps to Upgrade 
from FIX 7.x section. 

Preparing for the Upgrade to iFIX with FIX Desktop 
The following sections describe the steps you need to take to prepare your computer for upgrading to 
iFIX with FIX Desktop. These sections are presented in the order that you should proceed with each 
task. These tasks are also outlined in the list below. 

To prepare for the upgrade:  

1. Convert recipes to the required format by Preparing the Recipe Files for the Upgrade.  

2. Export I/O driver information by Preparing the I/O Drivers for the Upgrade.  

3. Record the enabled environmental protection options by Checking the Environmental 
Protection Settings.  

4. Be sure to save all required files by Backing Up FIX Files.  

5. Compile a list of user accounts by Exporting a Report of the Security Configuration.  

6. Edit the user accounts in the report file by Adding Passwords to the .RPT File.  

7. Finish by Generating a System Configuration Report.  

Preparing the Recipe Files for the Upgrade 

If any of your current FIX32 projects uses recipes, you will need to convert these recipes to .rcx 
(Master text) and .rcy (Control text) files before you upgrade to iFIX with FIX Desktop. These recipes 
are located in the FIX32 RCM and RCC folders. This step is necessary so that you can import your 
recipes after installing iFIX with FIX Desktop. 
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To convert your recipes to .rcx and .rcy files:  

1. Start FIX32.  

2. If security is enabled, log in using a user account with Administrator rights.  

3. Start the FIX32 Recipe Manager, RCP.EXE.  

4. Save each master recipe as a .rcx file:  

a. Open the master recipe (.RCM file).  

b. On the File menu, click Save As. The Recipe Mod Log dialog box appears.  

c. Click Save As. The recipe Save As dialog box appears.  

d. From the Save File As Type drop-down list, select Master text (*.rcx).  

e. Confirm that the location is the RCM folder and the file name is the same as the 
original file.  

f. Click OK.  

5. Save each control recipe as a .rcy file:  

a. Open the control recipe (.rcc file).  

b. On the File menu, click Save As. The Recipe Mod Log dialog box appears.  

c. Click Save As. The recipe Save As dialog box appears.  

d. From the Save File As Type drop-down list, select Control text (*.rcy).  

e. Confirm that the location is the RCC folder and file name is the same as the original 
file.  

f. Click OK.  

6. Verify that you saved all recipes by inspecting the FIX32\RCC and FIX32\RCM folders.  

Preparing the I/O Drivers for the Upgrade 

Before you upgrade to iFIX with FIX Desktop, GE Fanuc recommends that you use the driver 
configuration program to export the driver information into .CSV files. By default, these files are saved 
to the FIX32/PDB folder. You use these .CSV files later to import the driver information into the 
upgraded system.  

Later in the install process, after importing the driver files, you can verify the driver migration and 
convert the process database for use with iFIX and FIX Desktop. 
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To export the driver configuration:  

1. Start the current installation of FIX (if it is not already running).  

2. If security is enabled, log in using a user account with Administrator rights.  

3. Start the System Configuration Utility (SCU).  

4. On the Configure menu, click SCADA. The SCADA Configuration dialog box appears.  

5. Select an installed driver (other than SIM or DDE), and click the Configure button. The 
Driver Configurator program starts.  

6. Select the first channel, CHANNEL1, in the browser on the left side of the window.  

7. On the File menu, click Save As. The Save As dialog box appears.  

8. Leave the default location of FIX32\PDB, and enter a name for the file in the File Name field.  

9. From the Save as Type drop-down list, select Text Files (*.CSV).  

10. Click Save.  

11. Repeat steps 6-10 for each channel of the driver that is currently installed. Note the file names 
and their location for later use.  

12. Repeat steps 5-11 for each I/O driver installed on your system.  

13. Exit the SCU.  

Checking the Environmental Protection Settings 

Before the upgrade to iFIX with FIX Desktop, you should open the Environment Protection dialog in 
the Draw application and record these settings. After the upgrade, you cannot access this dialog box 
from Draw. Instead, you configure all environmental protection options in the Proficy iFIX 
WorkSpace. 

To record your current environment protection settings:  

1. Start FIX.  

2. Open the Draw application.  

3. On the Edit menu, click Environment. The Environment Protection dialog box appears.  

4. Inspect and record the enabled options.  

Backing Up FIX Files 

After you create the support files for your recipe and I/O driver upgrades, you can proceed to back up 
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your FIX 7.x files. Create a new folder on your computer, separate from the FIX 7.x (FIX32) folder, 
for the files you want to save.  

After you back up the FIX files, you may also want to copy this new folder to another location, such as 
a network drive or a removable media, as a safeguard until the migration is complete. 

The following table lists the files and folders that you must back up.  

Files or Folder to 
Copy 

Location Description of FIX32 Component 

*.PDB, *.CSV, *.GDB, 
all driver configuration 
files 

FIX32\PDB Process database and driver configuration 
files.  

*.ODF FIX32\PIC Picture files. 

*.ODT FIX32\PIC Template files for pictures. 

*.TGE FIX32\PIC Tag Group Editor files. 

*.KMX FIX32\PIC Key Macro Editor files. 

*.LYT FIX32\PIC Layout files. 

*.SBL FIX32\PIC Custom Dynamos. 

*.RCX FIX32\RCM Master recipe files, in text format.  

NOTE: These files do not appear unless you 
followed the steps in the Preparing the 
Recipe Files for the Upgrade section. 

*.RCY FIX32\RCC Control recipe files, in text format. 

NOTE: These files do not appear unless you 
followed the steps in the Preparing the 
Recipe Files for the Upgrade section. 

Draw.ini, View.ini, 
*.RPT 

FIX32\LOCAL Initialization settings for the Draw and View 
applications, and report files. 

Entire HTRDATA 
folder 

FIX32\HTRDATA Collected historical data. 

Entire HTR folder FIX32\HTR Historical collection preferences. 
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Files or Folder to 
Copy 

Location Description of FIX32 Component 

Entire ALM folder FIX32\ALM Alarm file and event log. 

Entire APP folder FIX32\APP Custom data and configuration files for your 
iFIX applications.  

To back up the required files:  

1. Create a new folder on your computer, separate from the FIX32 folder, for the files you want 
to save.  

2. Copy the entire PDB folder into this new folder. The PDB folder includes the process 
database and driver configuration files (*.PDB, *.CSV, *.GDB, all driver configuration files).  

3. Copy the entire PIC folder, which includes all displays, display templates, tag groups, key 
macros, layouts, and custom Dynamos (*.ODF, *.ODT, *.ODT, *.TGE, *.KMX, *.LYT, and 
*.SBL files).  

4. Copy the converted master recipe files (*.RCX) in the RCM folder.  

5. Copy the converted control recipe files (*.RCY) in the RCC folder.  

6. Copy the initialization settings for the Draw and View applications and report files (Draw.ini, 
View.ini, *.RPT) from the LOCAL folder.  

7. Copy the entire HTRDATA folder, which includes all collected historical data.  

8. Copy the entire HTR folder, which includes your historical collection preferences.  

9. Copy the entire ALM folder, which includes all alarm files and event logs.  

10. Copy the entire APP folder, which includes any custom data and configuration files for your 
iFIX applications.  

11. After you copy all of these files, you may want to back up these files to another location, such 
as a network drive or a removable media, as a safeguard until the migration is complete.  

Exporting a Report of the Security Configuration 

Before you upgrade to iFIX with FIX Desktop, you need to export a report from the FIX Security 
Configuration application. This report includes a list of iFIX users along with the application features 
configured for each user in your FIX applications. Save this file along with the other FIX files and 
folders that you backed up. 

IMPORTANT: Passwords are not exported with the security configuration report; you must re-enter 
the passwords manually. See the Adding Passwords to the .RPT File section for details. This policy is 
for security purposes. 
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After you install iFIX and FIX Desktop (in the same language as the original install), you can import 
this report file into your new security configuration to recreate the user accounts on the upgraded 
system. You can also use this printed report as a cross reference when you reassign the new application 
features to each user.  

To export a list of user accounts:  

1. Start the current installation of FIX (if it is not already running).  

2. If security is enabled, log in using a user account with Administrator rights.  

3. Start the System Configuration Utility (SCU).  

4. On the Configure menu, click Security to enter the Security Configuration.  

5. On the File menu, click Export. The Select File dialog box appears.  

6. Browse to the folder that you want to save the file to. By default, this folder is the 
FIX32\Local folder. Most likely you will want to save this file to the location where you 
backed up the other FIX files.  

7. Use the default name for the .RPT file, which is Security.RPT.  

8. Click Save.  

9. Open this report in a text editor such as Notepad or Wordpad and print a copy.  

Adding Passwords to the .RPT File 

The report file that you export from the Security Configuration application does not include user 
passwords. This is done to protect your system.  

If you later try to import this file into the Security Configuration application without the passwords, 
none of the iFIX user accounts will require passwords. In this case, you would need to re-enter each 
password manually. You can avoid this step entirely by editing each account in the report file from a 
text editor before the migration.  

To add passwords to your exported file with the security configuration:  

1. Open the Security.RPT file in a text editor such as Notepad or WordPad. By default this file is 
located in the Local folder, on the FIX32 node.  

2. Search the file for the first instance of the word User: in the report. For example:  

User: GUEST 

Login-name: GUEST 

Timeout: 00:00:00 

Feature: View 
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3. Insert the text Password: after the user's login name.  

4. Type the user's password after the colon. An example of what this might look like is as 
follows:  

User: GUEST 

Login-name: GUEST 

Password: GUEST 

Timeout: 00:00:00 

Feature: View 

5. Scroll down through the report and repeat steps 3 and 4 for each user in the report.  

Generating a System Configuration Report 

Before you migrate to iFIX with FIX Desktop, it's a good idea to create a system configuration report. 
This report includes information that you may need later when you are configuring your SCU. It is also 
helpful if you want to verify your system after the migration. This report includes: 

• General node configuration information, such as the node and setup file name, as well as 
SCADA, network, NLS, and security options.  

• System path locations for base, local, language, database, pictures, and so on.  

• SCADA configuration such as the name and number of I/O drivers.  

• Alarm configuration information such as default message format, application message 
routing, remote alarm areas, alarm network service, alarm summary, and alarm history service 
settings.  

• List of startup tasks.  

• SQL configuration.  

• Auto Alarm Manager configuration to send and receive alarms.  

This report contains valuable reference information on your current FIX system before the upgrade. 

Steps to Generate a System Configuration Report 

To generate a system configuration report:  

1. Start the current installation of FIX32 (if it is not already running).  

2. If security is enabled, log in using a user account with Administrator rights.  

3. Start the System Configuration Utility (SCU).  
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4. On the File menu, click Report. The Select Report Name dialog box appears.  

5. In the File Name field, leave the default name. The default name is the node name.  

6. Click Save. A report named NodeName.RPT is saved to the Local folder. A message appears 
when the save is complete.  

NOTE: NodeName is the name from step 5. 

7. Click OK to continue.  

Overview of Steps to Upgrade from FIX 7.x 
After you complete the steps described in the Preparing for the Upgrade to iFIX with FIX Desktop 
section, you can proceed to the actual product upgrade.  

To upgrade from FIX 7.x:  

1. Complete the steps for Installing the iFIX Software.  

2. Follow the steps for Installing the FIX Desktop Software.  

3. Update the Database Dynamos. 

4. Install the Newest Drivers and iFIX Product SIMs.  

5. Copy the Backed Up Files into the New Product Folder.  

6. Import the FIX I/O Driver Configuration Information.  

7. Verify the I/O Driver and Database Migration.  

8. Import the Recipes Files.  

9. Import the Security Configuration.  

10. Reconfigure the Application Features and Passwords for Each User.  

11. Redefine SCADA Failover Settings.  

12. Enable Environmental Protection.  

13. Setup the Report Generator.  

Update Database Dynamos 
To use FIX 7.x Database Dynamos in iFIX with FIX Desktop, you must recompile them with the iFIX 
Database Dynamo Toolkit. Follow the steps outlined in the iFIX Database Dynamo Toolkit and the 
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Database Converter will update your Database Dynamos. The Database Converter runs whenever iFIX 
is started. 

For information on the Database Dynamo toolkit, contact GE Fanuc. 

Install the Newest Drivers and iFIX Product SIMs 
You must install the most current drivers before you migrate the Process Database (PDB) from FIX32 
to iFIX with FIX Desktop. This is necessary so that your FIX32 applications can migrate properly to 
iFIX with FIX Desktop. 

You can install the newest drivers from the most current Driver CD, or by obtaining the driver file 
from the Proficy GlobalCare Support web site, http://support.gefanuc.com. 

To install the driver, follow the instructions that came with your driver CD, or with your download. If 
you install a driver from the web, the process generally entails extracting files from a .EXE and 
running a simple install program or manually copying files. Refer to the driver documentation for 
information on the install process.  

After obtaining and installing the latest drivers, GE Fanuc recommends checking for the latest patches 
for the iFIX product. Obtain all applicable iFIX SIMs and add-ons from the Proficy GlobalCare 
Support web site, http://support.gefanuc.com. Install these SIMs on top of the current iFIX installation. 

To install the newest drivers and iFIX product SIMs:  

IMPORTANT: You must install the most current drivers before you migrate the Process Database 
(PDB) files from FIX32 to iFIX. This step is necessary so that your FIX32 applications can migrate 
properly to iFIX. 

1. Obtain the latest the most current Driver CD or the driver update from the GlobalCare 
Support web site, http://support.gefanuc.com.  

2. Follow the instructions that came with your driver CD, or the information included with the 
driver download.  

3. Check for the latest patches for the iFIX product. Obtain all applicable iFIX SIMs and add-
ons from the GlobalCare Support web site, http://support.gefanuc.com.  

4. Install these SIMs on top of the installed iFIX product.  

5. Do not start iFIX.  

Copy the Backed Up Files into the New Product Folder 
After iFIX with FIX Desktop is installed, along with the drivers, appropriate SIMs, and hardware key, 
you can copy your previous FIX32 files into the new iFIX with FIX Desktop install location. As you 
remember, you backed up these files before beginning the iFIX with FIX Desktop installation. The 
default iFIX install folder is: C:\Program Files\GE Fanuc\Proficy iFIX. 

The following table lists the files to copy from your backup folder, and the location to copy them to 
(assuming you used the default iFIX directory).  
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Files to Copy Location to Copy in iFIX Folder 

*.PDB, *.CSV, *.GDB all driver configuration files PDB 

*.ODF PIC 

*.ODT PIC 

*.TGE PIC 

*.KMX PIC 

*.LYT PIC 

*.SBL PIC 

*.RCX RCM 

*.RCY RCY 

Draw.ini, View.ini, *.RPT LOCAL 

HTRDATA/*.* HTRDATA 

HTR/*.* HTR 

ALM/*.* ALM 

APP/*.* APP 

To copy the backed up files into the appropriate Proficy iFIX product folders:  

1. Copy the *.PDB, *.CSV, and *.GDB files from the FIX32 PDB folder into the iFIX PDB 
folder.  

NOTE: If you installed iFIX to the default location, the iFIX folders are located in this path: 
C:\Program Files\GE Fanuc\Proficy iFIX. 

2. Copy the contents of the FIX32 PIC folder into the iFIX PIC folder.  

3. Copy the *.RCX files into the iFIX RCM folder.  
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4. Copy the *.RCY files into the iFIX RCC folder.  

5. Copy the Draw.ini, View.ini, *.RPT files for FI32X into the iFIX Local folder.  

6. Copy the contents of the FIX32 HTRDATA folder into the iFIX HTRDATA folder.  

7. Copy the contents of the FIX32 HTR folder into the iFIX HTR folder.  

8. Copy the contents of the FIX32 ALM folder into the iFIX ALM folder.  

9. Copy the contents of the FIX32 APP folder into the iFIX APP folder.  

Import the FIX I/O Driver Configuration Information 
After you copy the backed up FIX files into your new iFIX with FIX Desktop folder, you are ready to 
import the I/O driver configuration information.  

To import the I/O driver configuration information:  

1. Start the iFIX SCU, by clicking the Start button, pointing to Programs, Proficy HMI SCADA 
- iFIX, and then System Configuration.  

2. Verify that the Node name that appears on the main screen is correct. Refer to the 
NodeName.RPT report described in the Generating a System Configuration Report section if 
you are unsure of the name.  

3. Double-click the Database Name to enter the database name you want to use. The Database 
Definition dialog box appears. Ensure it is the same name as the previous project.  

4. Click OK. A prompt appears stating that the database does not exist.  

5. Select Yes, and use the database anyway.  

6. On the Configure menu, click SCADA. The SCADA Configuration dialog box appears.  

7. Verify that the required drivers appear in the Configured I/O Drivers list. If required, add the 
SIM, DDE, and any other required driver to the Configured I/O Drivers list.  

8. Click OK, and then Yes when prompted.  

9. On the File menu, click Save.  

10. Close the SCU.  

11. Click Start and point to Programs, Proficy HMI SCADA - iFIX 5.0, and then iFIX 5.0 to 
launch the iFIX Startup dialog box.  

12. Make sure the local node name is correct, and click the button in this dialog box to start iFIX.  
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13. When iFIX is running, start the SCU again.  

14. On the Configure menu, click SCADA. The SCADA Configuration dialog box appears.  

15. Verify each driver configuration is correct by selecting the driver and then clicking the 
Configure button. The Driver Configurator opens.  

If the driver configuration is correct, you can close the Driver Configurator and proceed to 
step 24.  

If you need to make changes, you can make the necessary changes, save the file, and proceed 
to step 24. Otherwise, import the driver configuration by following steps 16-22. 

16. Select the first channel, CHANNEL1, in the browser on the left side of the window.  

17. On the File menu, click Open. The Open dialog box appears.  

18. From the Save as Type drop-down list, select Text Files (*.CSV).  

19. Select the .CSV file for the channel.  

20. Click Open.  

21. Repeat steps 16-20 for each channel of the driver that is currently displayed.  

22. Repeat steps 15-21 for each I/O driver installed on your system.  

23. When you finish these tasks for all drivers, on the File menu, click Save and exit the Driver 
Configurator.  

24. Save and Exit the SCU.  

Verify the I/O Driver and Database Migration  
After configuring the SCU, complete the following procedure to verify the migration of the I/O drivers 
and to convert the Process Database. 

To verify the migration:  

1. Start iFIX.  

2. Start Mission Control from the Proficy iFIX WorkSpace. You can find the button to launch 
Mission Control in the WorkSpace tree.  

3. Examine the information on the I/O Control tab. Ensure that data is being polled. If data is 
present, advance to Step 6.  

4. If there is no data present, ensure that the driver is loaded and is running. Exit Mission 
Control and select System Configuration to start the SCU.  
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5. On the Configure menu, click SCADA. The SCADA Configuration dialog box appears.  

6. Select the I/O driver and verify that the Poll Records are present. If they are not present, 
repeat the steps in the Import the FIX I/O Driver Configuration Information section.  

7. Maximize the Proficy iFIX WorkSpace and then:  

a. Start Database Manager from the WorkSpace System Tree.  

b. Verify that the I/O addresses for your data blocks are correct.  

8. Save and exit Database Manager.  

Errors that occur during the database conversion are written to the error log file (dbcvt.err). 
You can open this file in any text editor. Use this log file to identify the individual tags 
causing the problems. Consult the online help or contact GE Fanuc for more details on how to 
troubleshoot database conversion errors.  

Import the Recipes Files 
After converting and successfully running the I/O Drivers and Process Database, you can import the 
recipes that you previously saved as .rcx and .rcy files. 

To import recipe files:  

1. From the Proficy iFIX WorkSpace, select the FIX Recipes folder in the system tree.  

2. Double-click the New Recipe icon. The Recipe Development utility appears.  

3. Open each .rcx file in the iFIX RCM folder and save each file as a .rcm file.  

4. Open each .rcy file in the iFIX RCC folder and save each file as a .rcc file.  

5. When you are finished, exit the Recipe Development utility.  

Import the Security Configuration 
When you import the security configuration file that you created before the install, all your FIX 32 
users are re-added to the iFIX with FIX Desktop software. Later you will need to re-enter passwords 
for these users and redefine the application features assigned to each user, since the iFIX with FIX 
Desktop software includes new and reassigned application features. However, before you can do that, 
you need to import the list of users from the security configuration. 

To import the list of users from the security configuration:  

1. Start the current installation of FIX (if it is not already running).  

2. From the Proficy HMI SCADA - iFIX program group, start the System Configuration 
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application. The SCU opens.  

3. On the Configure menu, click Security. The Security Configuration application appears.  

4. On the File menu, click Import. The Select File dialog box appears.  

5. Browse to the folder that you copied the original .RPT file to. By default, this folder is the 
C:\Program Files\GE Fanuc\Proficy iFIX\Local folder.  

6. Select the file and click Open. A message box appears warning you that the imported user 
accounts will not contain passwords.  

IMPORTANT: Be aware that you cannot import a security file exported from another 
language.  

7. Click Yes to continue. Another message box appears requesting that you replace or add this 
file to the existing configuration.  

8. Click Replace.  

IMPORTANT: Do not shut down the SCU before moving on to the next set of steps. If you 
did not add passwords to the user accounts before you migrated, as described in the Adding 
Passwords to the .RPT File section, you could possibly lock yourself out, if security is 
enabled. 

9. Continue by following the steps in the Reconfigure the Application Features and Passwords 
for Each User section.  

Reconfigure the Application Features and Passwords for Each 
User 
After you import the security configuration (.RPT) file, you can proceed to reconfigure the features 
available for each user and reassign new passwords, if you did not already do so.  

Use the Security Configuration program to open each group profile and user profile, assign application 
features, and create a new password (if a password is required). Use the printout that you created in the 
Exporting a Report of the Security Configuration as a reference when reassigning the application 
features to users on the upgraded system. This printout lists the original application features available 
for each user. 

Refer to the following sections when comparing this printed list of features with the features that 
appear in the Application Features Selection dialog box. 

• Identical Application Features in FIX32 and iFIX with FIX Desktop  

• FIX32 Application Feature Names That Are Different After the Upgrade  

• FIX32 Application Features No Longer Available After the Upgrade  

• New Application Features Available for iFIX Users  
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To assign the application features and a password to each user:  

NOTE: The SCU should still be open from the previous set of steps in the Import the Security 
Configuration section. 

1. On the Configure menu, click Security. The Security Configuration application appears.  

2. On the Edit menu, click User Accounts.  

3. Select a user and click Modify. The User Profile dialog box appears.  

4. In the Password field, enter a new password if you want to assign a password.  

5. Click the Modify button beneath the Application feature list (the list on the right-side of the 
window). The Application Feature selection dialog box appears.  

6. Add the required features. Click Add All if you want to allow this user to use all application 
features.  

See the sections that follow for information on the names used with each feature and the new 
features available.  

7. Click OK.  

8. Click OK to exit the User Profile dialog box.  

9. Repeat steps 3-8 for each user listed in the User Accounts dialog box.  

10. Click OK to exit the User Accounts dialog box.  

11. On the Edit menu, click Group Accounts. The Group Accounts dialog box appears.  

12. Select a group and click Modify. The Group Profile dialog box appears.  

13. In the Application Features area, click Modify. The Application Feature selection dialog box 
appears.  

14. Add the required features. Click Add All if you want to allow this group to use all application 
features.  

15. Click OK.  

16. Click OK to exit the Group Profile dialog box.  

17. Repeat steps 12-16 for each group listed in the Group Accounts dialog box.  

18. On the File menu, click Save to save the security configuration.  

19. On the File menu in the Security Configuration program, click Exit to return to the SCU.  

20. Save and exit the SCU.  
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Identical Application Features in FIX32 and iFIX with FIX Desktop 

After you import your security configuration, the following application features are automatically 
imported for each user. You do not need to assign these features again after the upgrade since the same 
names are used for FIX32 and iFIX with FIX Desktop: 

• Background Task Exit  

• Database Reload  

• Database Save  

• Historical Trend Assign  

• Historical Trend Collection  

• Historical Trend Export  

• Recipe Load  

• Recipe Save  

• Security Configuration  

• System Configuration  

• System User Login  

• System User Logout  

• Tag Group Editor  

NOTE: While the Tag Group Editor applications may be different executables for Draw and the 
Proficy iFIX WorkSpace, they both use the same application feature. 

FIX32 Application Feature Names That Are Different After the Upgrade 

After you upgrade to iFIX with FIX Desktop, you will notice that some of the FIX32 features 
correspond to different names in iFIX with FIX Desktop. These features do not automatically appear in 
the user's application feature list. You need to add these again.  

For instance, to allow a user to access Draw, you need to add the WorkSpace Configure feature to the 
user's application feature list. By doing this, the user has the same access to both Draw and the Proficy 
iFIX WorkSpace in configure mode.  

Similarly, to allow access to the View application, you need to add the WorkSpace Runtime feature to 
the user's application feature list. By doing this, the user has access to both View and the Proficy iFIX 
WorkSpace in run mode. 

The application feature names are different because they take into account changes to support the iFIX 
system. As another example, since the FIX32 Database Builder is replaced with the iFIX Database 
Manager, you need to add the Database Manager to the user's feature list since the supported 
application actually changed with the upgrade. 
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When re-assigning these features for each user, use the following table to locate the FIX32 feature 
name and determine the corresponding name in iFIX with FIX Desktop.  

Feature Name for FIX32 Feature Name for iFIX with FIX Desktop 

Database Builder,  
Database Create 

Database Manager 

Draw WorkSpace Configure 

View WorkSpace Runtime 

Report Creator Fix32 - Report Creator 

Key Macro Editor Fix32 - Key Macro Editor 

Operating System Window Fix32 - Operating System Window 

FIX - System Shutdown iFIX - System Shutdown 

Alarm Summary Display Fix32 - Alarm Summary Display 

Historical Trend Display Fix32 - Historical Trend Display 

Run a Task from View Fix32 - Run a Task from View 

Report Generator Fix32 - Report Generator 

Historical Display Configuration Fix32 - Historical Display Configuration 

Exit from View WorkSpace Runtime Exit 

Database Block Add/Delete Database Block Add-Delete 

GUI Recipe Builder Operations Window Recipe Builder Operations Window 

GUI Recipe Builder Development Window Recipe Builder Development Window 

GUI Recipe Save Recipe Save from Recipe Builder 
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Feature Name for FIX32 Feature Name for iFIX with FIX Desktop 

GUI Recipe Download Recipe Download from Recipe Builder 

GUI Recipe Upload Recipe Upload from Recipe Builder 

GUI Recipe Text Output Recipe Text Output from Recipe Builder 

GUI TASK Switching Enable Task Switching 

GUI System Reboot Enable Ctrl-Alt-Del 

Historical Trend Display View Only Fix32 - Historical Trend Display View Only 

CDA Feature 1 - 54 EDA Feature 1 - 54 

FIX32 Application Features No Longer Available After the Upgrade 

In iFIX with FIX Desktop, it is no longer applicable to include security for these features, many of 
which are FIX BOS related or discontinued: 

• All features that begin with the word: Batch  

• Data Transfer Utility  

• Dial Manager for Modem Support  

• Ingredient Manager  

• Inventory Manager  

• Procedure Monitor  

• Procedure Monitor - Hold/Resume Control  

• Procedure Monitor - Modify Parameters  

• Procedure Monitor - Run/Skip Control  

• Procedure Monitor - Stop Procedure  

• Quality Test Manager  

• Recipe Handler  
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• Recipe Manager  

• Recipe Manager - Authorize  

• Recipe Manager - Remove  

• Report Manager  

• Scheduler  

• Scheduler Configuration  

New Application Features Available for iFIX Users 

By upgrading to iFIX with FIX Desktop, you also obtain some new features that you can assign to 
your iFIX users. The features that you can choose from include: 

• Application Validator - Creation of Baselines  

• Application Validator - Run-time Access  

• Change Management 

• Electronic Signature - Bypass 

• Electronic Signature - Perform By  

• Electronic Signature - Verify By  

• GE Fanuc OEM Reserved 1-12 

• Manual Failover  

• Project Backup-Restore 

• Recipe Text Output from Recipe Builder 

• Runtime Visual Basic Editor Access  

• Security Synchronizer  

• Startup Profile Manager  

• VisiconX Writes 

• A group of Proficy Batch Execution product features available if you have this product 
installed (each feature starts with the word: Batch Execution)  

For more detailed information on using these features with your iFIX pictures, refer to the iFIX 
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Electronic Books. 

NOTE: iFIX does not include a separate Key Macro Editor application feature. For iFIX, the Key 
Macro Editor (FDKeyMacros.exe) does not run outside of the Proficy iFIX WorkSpace. So, security 
for this feature is set at the WorkSpace-level by allowing access to the WorkSpace Configure feature. 
For FIX32, the Key Macro Editor (KME.exe) can run alone without Draw running. This is why the 
Key Macro Editor appears as a separate entry for FIX32 for use with FIX Desktop. 

Redefine SCADA Failover Settings 
If your FIX32 applications used the failover feature prior to the iFIX 5.0 with FIX Desktop upgrade, 
you need to set up failover again. Be aware that, if you want to use failover, all nodes (primary, 
secondary, and view nodes) must be upgraded to iFIX with FIX Desktop. FIX32 failover is 
incompatible with iFIX.  

One of the biggest changes required for iFIX failover is that you include a logical node name in your 
configuration. Failover in iFIX follows a different paradigm. In iFIX with FIX Desktop, the 
applications on the iClient communicate to the logical node name, and iFIX substitutes the physical 
node name at run time based on which SCADA server is available. The combination of the logical 
node name, and physical primary and secondary SCADA server names, is referred to as the primary 
and secondary pair. You configure the primary and secondary pair in the SCU of the iClient and of 
each SCADA server. 

For detailed instructions on configuring Enhanced Failover and LAN Redundancy in iFIX 5.0, refer to 
the Enhanced Failover and Redundancy e-book  in the iFIX Electronic Books. 

Enable Environmental Protection 
If your FIX applications used the environment protection feature prior to the iFIX with FIX Desktop 
upgrade, you need to enable it again. To enable this feature for iFIX and FIX Desktop, use the 
Environment Protection tab of the User Preferences dialog box of the Proficy iFIX WorkSpace, as 
shown in the following figure. 
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Environment Protection Options in the Proficy iFIX WorkSpace 

From this dialog box, you can enable the options that your applications require. When re-entering these 
settings, be sure to refer back to the settings that you recorded in the Checking the Environmental 
Protection Settings section, when you prepared for the iFIX with FIX Desktop upgrade. 

Important Note About Using Environment Protection 

When you use environmental protection for iFIX with FIX Desktop, be aware that some limitations 
apply to these options when View is running and the Proficy iFIX WorkSpace is in run mode: 

• Disable <Ctrl><Alt><Del>  

• Disable Task Switching  

If you exit the WorkSpace or View, either by shutting down one application or by switching the 
WorkSpace to configure mode while View is still running, these environmental protection settings no 
longer apply to the application still running. 

Understanding Environment Protection in iFIX 

When you upgrade to iFIX with FIX desktop, there are environmental protection settings that apply to 
both iFIX and View. There is also a FIX32 environmental protection setting that is unavailable after 
the upgrade. However, with the upgrade, there are also new settings now available in the Proficy iFIX 
WorkSpace. The sections that follow describe these changes. 
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Settings that Apply to Both the Proficy iFIX WorkSpace and View 

From the Environment Protection tab of the User Preferences dialog box, the following settings apply 
to both View and WorkSpace in run mode: 

• Disable Title Bar and Menu Bar  

• Disable Menu Bar  

• Disable <Ctrl><Alt><Del>  

• Disable Task Switching  

FIX32 Setting Still Available After the Upgrade 

The only environmental protection setting that does not appear in the Environment Protection tab of 
the User Preferences dialog box is as follows: 

Disable Pop-up Menu  

This setting is still available for FIX Desktop View, however, you must enable this setting through the 
FixUserPreferences.INI file. 

New Settings for the Proficy iFIX WorkSpace 

The remaining environmental protection options are new for the Proficy iFIX WorkSpace: 

• Disable "WorkSpace" Menu Pulldown  

• Disable VBE Access  

• Disable "WorkSpace" File Menu Accelerators  

• Disable Open Accelerator  

• Disable Print Accelerator  

For more details on these settings, refer to the table in the Understanding Environment Protection 
section. 

Steps to Enable Environment Protection 

The steps below explain how to enable environment protection feature after you upgrade. 

To enable the environment protection feature after you upgrade:  

1. Start iFIX.  

2. Shut down View and the WorkSpace if either is running.  

3. If you want to use the Disable Pop-up Menu option, open the FixUserPreferences.ini file in 
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the C:\Program Files\GE Fanuc\Proficy iFIX\Local folder. In the [AppRunPreferences] 
section, make the following change:  

PopUpMenu=0 

When the PopUpMenu=1, then the right-click pop-up menu is not available. When this value 
is set to 0, the pop-up menu is available in View.  

4. To set the other environment settings, open the Proficy iFIX WorkSpace.  

5. In Classic view, on the WorkSpace menu, click User Preferences.  

-Or- 

In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User 
Preferences.  

6. Select the Environment Protection tab.  

7. Select the Enable Run Time Environment Protection check box. After you enable this setting, 
the check boxes below become available.  

8. Select the options that you want to enable. Use the table in the Understanding Environment 
Protection section as a guide when assigning these options.  

NOTE: After you enable the environment protection feature in WorkSpace, you must 
shutdown View (if it is still running) and restart it for the environmental protection settings to 
apply.  

Understanding Environment Protection 

The following table outlines common tasks you may want to restrict operators from doing in the run-
time environment, and the environmental option associated with each task.  

To restrict an operator from... Select this check box... 

Closing the current picture displaying in 
View or the Proficy iFIX WorkSpace (in 
run mode). 

Disable Title Bar and Menu Bar.  

NOTE: Be sure to also select the Full Screen in Run 
mode check box from the General tab and clear the 
Title bar and Resizeable check boxes from the 
Picture Preferences tab. 

Switching from View or the Proficy iFIX 
WorkSpace (in run mode) to another 
application that may be running. 

Disable Task Switching 

Restarting the computer using 
Ctrl+Alt+Del or logging out of Windows 
when running View or the Proficy iFIX 

Disable <Ctrl><Alt><Del> 
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To restrict an operator from... Select this check box... 

WorkSpace (in run mode). 

Using the Proficy iFIX WorkSpace menu 
or switching to the configuration 
environment (while in run mode). 

Disable "WorkSpace" Menu Pulldown 

Accessing the Visual Basic Editor from 
the Proficy iFIX WorkSpace (while in 
run mode). 

Disable VBE Access. 

Using the Ctrl+O or Ctrl+P shortcuts in 
the Proficy iFIX WorkSpace (while in 
run mode). 

Disable "WorkSpace" File Menu Accelerators 

Using the Ctrl+O shortcut in the Proficy 
iFIX WorkSpace (while in run mode). 

Disable Open Accelerator 

Using the Ctrl+P shortcut in the Proficy 
iFIX WorkSpace (while in run mode). 

Disable Print Accelerator 

Setup the Report Generator 
If you used the Report Generator prior to upgrading to iFIX with FIX Desktop, and want to use the 
Report Generator on the upgraded system with Office 2000 or later, be sure to obtain and install SIM 
(software improvement module) number WAAE2371. 

You can obtain more information on this SIM and the files associated with it from the Proficy 
GlobalCare Support web site, http://support.gefanuc.com. This SIM is available in FIX32 product 
download area.  

If you are unsure if this SIM was installed before the upgrade, you can reinstall it.  

To install the files associated with this SIM:  

1. Copy the new file VDA2000.XLA to the directory in which your current Report Generator 
files exist.  

2. Copy the REPRTLNK.XLA, HIST_OPN.XLA and GEN.XLA files to the directory in which 
your current Report Generator files exist. REPRTLNK.XLA and GEN.XLA replace the 
existing Report Generator files which shipped with iFIX 4.0.  

3. Copy the STARTUP.XLA file to the directory in which your Excel Startup Directory exists. 
STARTUP.XLA replaces the existing Report Generator files.  

See the Proficy GlobalCare Support web site for more details. 
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Setting up for Remote OPC Server Access 
Before you can access remote OPC servers in iFIX, such as through the Discovery and Auto-Assembly 
Component (DAC) and the OPC Client driver, you must make sure that your firewall settings are 
correct (if you are using Windows XP or Windows Vista), and that the DCOM settings for your 
operating system are correct.  

You may not be able to access remote OPC servers if these settings are not correctly set. For more 
detailed information on configuring these settings, refer to the following topics: 

• Setting Up the Windows XP or Vista Firewall for Use with Remote OPC Servers 

• Setting Up DCOM for Use with Remote OPC Servers 

Setting Up the Windows XP or Vista Firewall for Use with 
Remote OPC Servers 
If Firewall security is enabled on Windows XP or Windows Vista, you may need to modify or add 
items to the Exceptions list.  

GE Fanuc recommends that you enter these settings on the local machine running iFIX, as well as on 
the remote machine that has the OPC server you want to use. 

To modify Windows Firewall settings: 

1. Log into the Windows operating system with an Administrator account. 

2. Open the Control Panel and double-click Windows Firewall. The Windows Firewall dialog 
box appears. For the Windows Vista operating system, you also need to click the "Allow a 
program through Windows firewall" option. 

3. Click the Exceptions tab and make sure that the File and Printer Sharing check box is 
selected. The following figure shows an example of this dialog box in Microsoft Windows 
XP. 
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4. Click the Add Port button. The Add a Port dialog box appears. The following figure shows an 
example of this dialog box in Microsoft Windows XP. 
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5. In the Name field, enter a name for the port. 

6. In the Port Number field enter 135. 

7. Select the TCP option. 

8. Click OK to save your changes. 

The port name you entered is now listed with its check box selected. 

9. Select the Add Program button. The Add a Program dialog box appears. The following figure 
shows an example of this dialog box in Microsoft Windows XP. 
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10. Click the Browse button. A Browse dialog box appears. 
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11. Navigate to the System32 folder. This folder is found under the operating system folder 
(usually Windows or WINNT). 

12. In the System32 folder, select the OPCENUM.exe file, and then click the Open button. 

In the Add a Program dialog box the path field displays the full path to, and including, the 
OPCENUM.exe file. 
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13. Click OK. 

OPCENUM.exe should now be listed in the Exceptions list with its check box selected. 
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14. Complete steps 9-13 for each OPC server that you want to access. 

NOTES:  

• If any OPC server that you want to use is a dll surrogate (an in-process dll and not an .exe), 
you must add \system32\dllhost.exe into the Exceptions list. 

• You must also add the GE Fanuc OPC Client driver by adding the file OPCDrv.exe into the 
Exceptions list. 

• OPCENUM must reside on the remote machine with the OPC server. While most OPC Server 
applications install and register this file, some do not. You can download this file from 
www.opcfoundation.org. Currently it is contained within the OPC Core Components 2.00 
Redistributable 2.30.msi file. After you download OPCENUM, run the .msi file. 

Setting Up DCOM for Use with Remote OPC Servers 
iFIX supports DCOM (Distributed Component Object Model) to browse remote OPC Servers. If you 
want to grant only certain users permission to launch or access the remote OPC servers, you can use 
the Windows utility, DCOMCNFG.EXE for configuring DCOM applications. DCOMCNFG.EXE is 
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usually located in your operating system’s \system32 folder. 

When OPC Servers register, they set up initial custom DCOM security settings to enable users on the 
network to access and launch the Server. On large networks, it is recommended that you modify these 
settings to avoid confusion and inadvertent changes to a running OPC Server. 

If Firewall security is enabled on Windows XP or Vista, you must also modify or add items to the 
Exceptions list. Refer to Setting Up the Windows XP or Vista Firewall for Use with Remote OPC 
Servers. 

IMPORTANT NOTES: 

• GE Fanuc recommends that all users that need to access remote OPC Servers be members of 
the Administrators group. To facilitate this, GE Fanuc recommends creating a users group to 
contain individual users that need to access remote OPC servers.  

For example, for the Discovery and Auto-Assembly Component, create a group named 
“DAC” and add those users who will log into the operating systems and access remote OPC 
servers. Add the users Tom, Denise, and Harry into the DAC group. Each of these users will 
also be added into the Administrators group. This DAC group should also contain the 
following built-in security principals: INTERACTIVE; NETWORK; SYSTEM. 

• To make any OPC Client / OPC Server application work via DCOM, changes need to be 
made on both sides, especially if you intend to use Asynchronous I/O communications. 

• OPCENUM must reside on the remote machine with the OPC server. While most OPC Server 
applications install and register this file, some do not. You can download this file from 
www.opcfoundation.org. Currently it is contained within the OPC Core Components 2.00 
Redistributable 2.30.msi file.  After you download OPCENUM, run the .msi file. 

• This section applies to OPC servers that need to use DCOM communications, regardless of 
whether the OPC server uses Serial or Ethernet devices. 

• If OPC communications is confined to a single machine (that is, using COM, but not DCOM), 
it continues to work properly without making changes to DCOM settings. 

• If you do not plan to use iFIX to connect remotely to OPC servers, then you may not need to 
change your DCOM settings. 

• If this is the first time you are connecting to (or allowing connections from) other machines 
on the network, you must run the Windows Network Wizard (from Start > Control Panel) to 
set up your computer to run on your network. This allows you to share resources on your 
computer with other computers on your network. It is recommended that you run the Network 
Setup Wizard before modifying the DCOM settings. 

DCOM Settings 

The following procedures provide general guidelines for configuring DCOM settings.  Differences 
between Windows 2003, Windows XP, and Windows Vista are noted. 

To launch the DCOM configurator: 

1. From the Start menu, select or type Run. The Run dialog box appears. 
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2. Type dcomcnfg and click OK. The Component Services dialog box appears. 

System-wide COM/DCOM Limits Settings 

This procedure modifies the system-wide DCOM settings for the computer on Windows XP and 
Windows Vista operating systems. When these steps are implemented, they apply to all programs that 
use COM/DCOM communications on the computer. 

IMPORTANT: Be careful when making any system-wide security changes. Any inadvertent changes 
may affect the entire system and may cause some or all programs to stop working. 

For Windows XP and Windows Vista: 

To update system-wide COM/DCOM limits settings: 

1. On the Component Services dialog box, expand Component Services, then expand the 
Computers item.  

2. Right-click My Computer and choose Properties. The My Computer Properties dialog box 
appears. 

3. Click the COM Security tab. There are four permissions on this dialog box. 

You may need to make changes to the Edit Limits… for Access Permissions and Launch and 
Activation Permissions. 

Do not change the Edit Default… settings, since this will change the default settings for all 
programs and applications running on the computer. 

4. Click Access Permissions > Edit Limits… The Access Permission dialog box appears. 

a. Select the user labeled ANONYMOUS LOGON, and then select the Allow check box 
for Remote Access. 

NOTE: This setting is necessary for applications that use OPCenum.exe to function 
and also for some OPC Servers and OPC Clients that set their DCOM 
‘Authentication Level’ to ’None’ to allow anonymous connections. If you do not use 
such applications, you may not need to enable remote access for anonymous logon 
users. 

b. Select the user labeled Everyone, and then select the Allow check box for Remote 
Access. 

IMPORTANT: Since “Everyone” includes all authenticated users, it is 
recommended to add these permissions to a smaller subset of users. One way of 
doing this is to create a Group named “OPC” and add all user accounts to this 
Group that will access any OPC server. Then substitute “OPC” everywhere that 
“Everyone” appears in the entire DCOM configuration dialogs. 

c. Click OK to close the Access Permissions dialog box and return to the My Computer 
Properties dialog box. 
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5. Click Launch and Activation Permissions > Edit Limits… The Launch Permission dialog box 
appears. 

For each user or group (preferably add the “OPC” group) that needs to launch or activate the 
OPC server, or participates in OPC / DCOM communications, make sure that the Local 
Launch, Remote Launch, Local Activation, and Remote Activation check boxes are selected. 

6. Click OK to save your changes, then click OK again to save and close the My Computer 
Properties dialog box. 

OPC Server-specific DCOM Settings 

The following procedures detail the OPC server-specific COM/DCOM settings on all supported 
Windows operating systems. You must change the OPC server settings so remote users can access the 
OPC server as an OPC Data Access Server. This procedure is also necessary for the GE Fanuc OPC 
Client driver to connect to, launch, configure, and start the remote OPC servers. 

GE Fanuc recommends that all users requiring access to remote OPC servers be members of the 
Administrators group. 

IMPORTANT: Since the “Everyone” group includes all authenticated users, it is recommended to 
add these permissions to a smaller subset of users.  
 
GE Fanuc recommends creating a group to contain individual users that need to access remote OPC 
servers. GE Fanuc also recommends that all users who require access to remote OPC Servers be 
members of the Administrators group. 
 
For example, for Discovery and Auto-Assembly Component, create a group named “DAC” and add 
those users who will log into the operating systems and access remote OPC servers. Add the users 
Tom, Denise, and Harry into the DAC group. Each of these users will also be added into the 
Administrators group. This DAC group should also contain the following built-in security principals: 
INTERACTIVE; NETWORK; SYSTEM. Then substitute “DAC” everywhere that “Everyone” appears 
in the entire DCOM configuration dialogs. 

To modify driver-specific DCOM settings: 

In Windows 2003 

1. Access the DCOM configurator (dcomcnfg.exe). The Component Services dialog box 
appears. 

2. Expand the Component Services item, then expand the Computers item, and then expand the 
My Computer item. 

3. Select the DCOM Config object. A list of applications displays. 

4. Right-click the OPC server you want to modify and choose Properties. The <Selected OPC 
Server> Properties dialog box appears. 

5. Click the General tab. The Authentication Level should be left as “Default”. This uses the 
default authentication rules that are set in the system-wide DCOM settings. 
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6. Click the Location tab and make sure that the Run Application on this computer check box is 
selected. 

7. Click the Security tab and select the Customize option for each of the permissions in this 
dialog box and edit them as described in the following steps. 

8. In the Launch Permissions area, click Edit. The Launch Permissions dialog box appears. 

9. Click the Add button. The Select Users and Groups dialog box appears. 

10. Click the Advanced Button. The Select Users and Groups dialog box appears. 

11. Click the Find Now button. In the search results, select the OPC group and click OK. The 
Select Users and Groups dialog box displays the OPC group.   

12. Click OK to return to the Launch Permission dialog box. The OPC group is displayed in the 
Group or user names list. 

13. Select the OPC group and select the Allow check box for Launch Permission. 

14. Click OK to return to the <Selected OPC Server> Properties dialog box. 

15. In the Access Permissions area, click Edit. The Access Permission dialog box appears. 

16. Click the Add button. The Select Users and Groups dialog box appears.  

17. Click the Advanced Button. The Select Users and Groups dialog box appears. 

18. Click the Find Now button. In the search results, select the OPC group and click OK.  The 
Select Users and Groups dialog box displays the OPC group.   

19. Click OK to return to the Access Permission dialog box. The OPC group is displayed in the 
Group or user names list.   

20. Select the OPC group and select the Allow check box for Access Permission. 

21. Click OK to return to the <Selected OPC Server> Properties dialog box. 

22. In the Configuration Permissions area, click Edit. The Change Configuration Permission 
dialog box appears. 

23. Click the Add button. The Select Users and Groups dialog box appears.  

24. Click the Advanced Button. The Select Users and Groups dialog box appears. 

25. Click the Find Now button. In the search results, select the OPC group and click OK. The 
Select Users and Groups dialog box displays the OPC group. 

26. Click OK to return to the Change Configuration Permission dialog box. 
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27. Select the OPC group and select the Allow check boxes for Full Control and Read, 

28. Click OK to return to the <Selected OPC Server> Properties dialog box. 

29. Click OK. 

30. Repeat steps 2 through 29 for each OPC server you need to access remotely. 

31. When you are done, close the Component Services dialog box. 

In Windows XP and Windows Vista 

1. Access the DCOM configurator (dcomcnfg.exe). The Component Services dialog box 
appears. 

2. Expand the Component Services item, then expand the Computers item, and then expand the 
My Computer item. 

3. Select the DCOM Config object. A list of applications displays. 

4. Right-click the OPC server you want to modify and choose Properties. The <Selected OPC 
Server> Properties dialog box appears. 

5. Click the General tab. The Authentication Level should be set to “Default,” if it is not already. 
This uses the default authentication rules that are set in the system-wide DCOM settings. 

6. Click the Location tab and make sure that the "Run Application on this computer" check box 
is selected. 

7. Click the Security tab and select the Customize option for each of the permissions in this 
dialog box and edit them as described in the following steps. 

8. In the Launch and Activation Permissions area, click Edit. The Launch Permission dialog box 
appears for Windows XP, or the Launch and Activation Permission dialog box appears for 
Windows Vista. 

9. Click the Add button. The Select Users or Groups dialog box appears.  

10. Click the Advanced Button. Another Select Users or Groups dialog box appears. 

11. Click the Find Now button. In the search results, select the OPC group and click OK. The 
Select Users or Groups dialog box displays the OPC group.   

12. Click OK to return to the Launch Permission dialog box. The OPC group is displayed in the 
Group or user names list. 

13. Select the OPC group and then select the Allow check boxes for Local Launch, Remote 
Launch, Local Activation, and Remote Activation permissions. 

14. Click OK to return to the <Selected OPC Server> Properties dialog box. 
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15. In the Access Permissions area, click Edit. The Access Permission dialog box appears. 

16. Click the Add button. The Select Users or Groups dialog box appears.  

17. Click the Advanced Button. Another Select Users or Groups dialog box appears. 

18. Click the Find Now button. In the search results, select the OPC group and click OK. The 
Select Users or Groups dialog box displays the OPC group.   

19. Click OK to return to the Access Permission dialog box. The OPC group is displayed in the 
Group or user names list. 

20. Select the OPC group and then select the Allow check boxes for Local Access and Remote 
Access permissions. 

21. Click OK to return to the <Selected OPC Server> Properties dialog box. 

22. In the Configuration Permissions area, click Edit. The Change Configuration Permission 
dialog box appears. 

23. Click the Add button. The Select Users or Groups dialog box appears. 

24. Click the Advanced Button. Another Select Users or Groups dialog box appears. 

25. Click the Find Now button. In the search results, select the OPC group and click OK. The 
Select Users or Groups dialog box displays the OPC group.   

26. Click OK to return to the Change Configuration Permission dialog box. The OPC group is 
displayed in the Group or user names list. 

27. Select the OPC group and then select the Allow check boxes for Full Control and Read 
permissions. 

28. Click OK to return to the <Selected OPC Server> Properties dialog box. 

29. Click OK. 

30. Repeat steps 2 through 29 for each OPC server you need to access remotely. 

31. When you are done, close the Component Services dialog box. 
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iFIX and Windows Vista 
iFIX 5.0 supports Microsoft® Windows® Vista, Business, Enterprise, and Ultimate Editions. 
Additionally, for iClients, iFIX supports Microsoft® Windows® Vista Ultimate Edition. If you are 
upgrading your iFIX install, be aware that Microsoft does not recommend upgrading Windows XP or 
2003 to Windows Vista. 

When using iFIX in Windows Vista, be aware of the following limitations when working with these 
products: 

• GE Fanuc OPC Client Driver – If you want to run the OPC Client driver as a service, iFIX 
must also run as a service. Likewise, if you want to run iFIX as a service, the OPC Client 
driver must run as a service. You cannot run one as a service, without the other also running 
as a service.  

If you want to run the OPC Client driver on the Microsoft Windows Vista operating system, 
be sure to check with the vendor of your OPC Server software to see if your OPC Server 
supports Vista.  

• Third-Party OPC Servers – Be aware that at the time of the iFIX 5.0 release there were a 
limited number of OPC Servers supported on Windows Vista. iFIX was tested with the 
OPC20iFIX.exe (Intellution.OPCiFIX) Server – an OPC 2.05a (out of process) Data Server. 

• DDE Driver – The DDE driver is not supported on Window Vista when iFIX is configured to 
run as a service." 

• Proficy Historian – You cannot install or use the Proficy Historian on Windows Vista. In 
other words, you cannot collect iFIX data with Proficy Historian or chart against Proficy 
Historian tags in Windows Vista.  

• Proficy Change Management – Running the Proficy Change Management (PCM) Server or 
the Client/Scheduler on iFIX 5.0 nodes is not supported on Microsoft Windows Vista, since 
Proficy Change Management 5.6 and 5.7 do not support Windows Vista.  

• NetDDE – NetDDE (NetDDE.exe) is not supported on Windows Vista for security reasons. 
Windows Vista cannot serve out DDE shares. 

• Terminal Server – iFIX does not support running a Terminal Server on Windows Vista, or 
an upgraded server running Remote Desktop Protocol (RDP) 6.0. However, iClients installed 
on Windows Vista using RDP 6.0 can connect to a server node running Windows 2000 
Server, Windows 2000 Advanced Server, or Windows Server 2003, with RDP 5.0, 5.1, or 5.2. 

• Drivers and DAC – If you want to run a driver on the Microsoft Windows Vista operating 
system, be sure to check with the vendor of your driver software to see if your driver supports 
Vista. Your driver must support Vista to interface with the Discovery and Auto-Assembly 
Component (DAC) on Windows Vista.  

• Biometric Toolkit – The iFIX Biometric Toolkit is supported in Windows Vista only if you 
have a biometric solution that is Windows Vista compatible.  
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• VisiconX – Make sure that your data sources use UNC pathing, rather than mapped network 
drives. For example, use a path like this: \\myserver\users\\mydb.mdb, instead of this: 
d:\myserver\users\mydb.mdb for your data source. Otherwise, you may experience connection 
errors. 

• PMON – The GE Fanuc diagnostic utility PMON.exe does not work when iFIX is running as 
a service in Windows Vista. 

• Proficy Portal Control – For best performance in Windows Vista, it is recommended that 
when you insert Proficy Portal control into your iFIX picture, that you do not insert any other 
ActiveX controls into the same picture.  

Additionally, be aware of the following differences when working with iFIX in Windows Vista, as 
opposed to other operating systems: 

• Security – Microsoft Windows Vista includes many new security enhancements. Due to these 
enhancements, there may be changes you need to make for the users who run iFIX. For more 
information, refer to the Windows Vista and Security section. 

• Drive Mapping – Security and data protection enhancements in Windows Vista may require 
you to use data sources with UNC pathing, as opposed to mapped network drives. For more 
information, refer to the Windows Vista and Mapped Network Drives section. 

• Sleep Mode – Be aware that an iFIX View node running on Window Vista will lose its 
connection to the iFIX network when going into "Sleep" mode.  

Windows Vista and Security 
In Windows Vista, the basic user groups changed. There are three main types: Administrators, Users, 
and Guests. In Windows Vista, the Power Users group can exist; however, it is a modified version of 
the standard Users group. Like Power Users, the standard Users group allows for some of the rights 
granted to Administrators, but not all.  

As an Administrator, you have all of the rights you need to operate a SCADA node (start and stop 
iFIX), as well as run iFIX as a service. However, if you want to allow a user in the Power Users group 
to operate an iFIX SCADA node or run iFIX as a service, you need to make some adjustments to the 
user rights.  

To allow a Power User to operate an iFIX SCADA node, you need to add the individual user or group 
to the "Create Global Objects" policy. If you want the user or group to run iFIX as a service, then you 
need to run the GrantUserFixServiceRights command for the user or group. A user must be a Power 
User or greater to run a SCADA node on Windows Vista.  

NOTE: The DDE driver is not supported on Vista when iFIX is configured to run as a service. 

To allow a user who is not an Administrator to operate an iFIX SCADA node: 

1. In Windows Vista, log in as an Administrator. 

2. Click the Start button, and in the Search box, type secpol.msc and press Enter. The Local 
Security Policy window appears. 
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3. In the tree, double-click Security Settings, and then Local Policies, to view the contents of the 
Local Policies folder. 

4. Click the User Rights Assignment item to view the policies. 

5. Double-click the Create Global Objects policy. The Create Global Object Properties dialog 
box appears.  

6. Click Add User or Group. The Select Users or Groups dialog box appears. 

7. Enter an individual user name, or group name, such as "Power Users." 

8. Click OK to add the user. 

To allow a user who is not an Administrator to run iFIX as a service: 

1. In Windows Vista, click the Start button, and in the Search box, type Command Prompt and 
press Enter. If the Command Prompt does not appear immediately, double-click the 
Command Prompt from the list of results. 

2. In the Command Prompt window, type: 

GrantUserFixServiceRights GRANT FIX USERNAME 

where FIX is the name of the service (iFIX) that you want to grant rights to, and USERNAME is 
the name of the user or group that you want to grant rights to.  

Running iFIX as a Service with Other Services 

If you plan to run iFIX as a service on Windows Vista along with other services such as the iFIX 
scheduler, the OPC A&E Server, and the OPC DA Server, make sure that your user has the rights to 
start/stop/pause all of those services. A user who is a member of the Administrators group usually has 
all these privileges. (This can be verified by opening the Windows service control panel and checking 
if the Start/Stop setting is enabled.) To grant a user who is a standard user (Power User) rights to 
start/stop/pause these services, log in to Windows as an Administrator and run the following 
commands: 

GrantUserFixServiceRights GRANT IFIXSCHEDULER username 
GrantUserFixServiceRights GRANT IFIXOPCAESRV username 
GrantUserFixServiceRights GRANT IFIXOPCDA username 

Examples: Using GrantUserFixServiceRights  

If you want to allow a Power User named QA1 to run iFIX as a service, type:  

GrantUserFixServiceRights GRANT FIX QA1 

If you want to allow all Power Users to run iFIX as a service, type:  

GrantUserFixServiceRights GRANT FIX "Power Users" 

If you later need to revoke the right to run iFIX as a service, use the following command: 

GrantUserFixServiceRights REVOKE FIX USERNAME 
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where SERVICENAME is the name of the service that you want to revoke rights from, and 
USERNAME is the name of the user or group that you want to revoke rights from.  

Windows Vista and Mapped Network Drives 
• In Windows Vista, when you elevate an application and it runs under a different context, the 

application may or may not be related to the user who is logged in. As a result, drive 
mappings are not available in an elevated session unless you specifically map them while it is 
being elevated. 

• To resolve this issue, make sure that your system data sources use UNC pathing, rather than 
mapped network drives. For example, use a path like this: \\myserver\users\\mydb.mdb, 
instead of this: d:\myserver\users\mydb.mdb for your data source. Otherwise, you may 
experience connection errors. Be sure to select the "Remember my password" check box in 
the Connection dialog box when setting up your UNC pathing. By doing this, the next time 
you log in, your connection will succeed without failing.  

For example, you add a system data source (ODBC) with a mapped network drive for use with 
VisiconX. When you configure a VisiconX data control and select a data source on the Database tab, 
an error appears (error number  -2147467259 indicates that you do have a vaild path). To resolve this 
issue, configure your data source with UNC pathing instead.  

EDA Applications and Windows Vista 
When running an iFIX Easy Database Access (EDA) application on Windows Vista, you may 
experience errors due to inadequate permissions. For instance, the logged in user may not have enough 
permissions to create the necessary global memory that the application requires, or the user may not be 
running an application with the fullest permissions (running elevated).  

The "Allocation of Shareable Memory Failed" message is one of the messages that can appear in this 
scenario. To resolve these types of issues, elevate the application to the fullest privileges.  

To mark an application for elevation using an external manifest: 

1. Create a text file named yourappname.exe.manifest, where yourappname is the name of the 
application you want to elevate. 

2. In a text editor such as Notepad, yourappname.exe.manifest. 

3. Paste the following lines of code into the text file: 

<?xml version="1.0" encoding="UTF-8" standalone="yes"?> 

<assembly xmlns="urn:schemas-microsoft-com:asm.v1" manifestVersion="1.0">  

  <assemblyIdentity version="1.0.0.0" 

     processorArchitecture="X86" 

     name="yourappname" 

     type="win32"/>  
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  <description>Description of your application</description>  

  <!-- Identify the application security requirements. --> 

  <trustInfo xmlns="urn:schemas-microsoft-com:asm.v2"> 

    <security> 

      <requestedPrivileges> 

        <requestedExecutionLevel 

          level="highestAvailable" 

          uiAccess="false"/> 

        </requestedPrivileges> 

       </security> 

  </trustInfo> 

</assembly> 

4. Save the file in the same folder as the yourappname.exe, where yourappname is the name of 
the application you want to elevate. 

TIP: If yourappname.exe was built with an internal manifest, yourappname.exe will ignore the 
external manifest created in the above manner. Instead, you need rebuild the application with 
the new elevation information. 

IMPORTANT: If you have run the executable before performing the above steps and it failed 
to work, see this link for information on adding a manifest after the fact: 
http://blogs.msdn.com/vistacompatteam/archive/2006/11/13/manifest-and-the-fusion-
cache.aspx.  

To mark an application for elevation with an internal manifest: 

• Build your application's executable (.exe) file with the elevation information built into it. Be 
aware of issues with fusion cache when you use an external manifest file. For more 
information, refer to the MSDN web site: 
http://blogs.msdn.com/vistacompatteam/archive/2006/11/13/manifest-and-the-fusion-
cache.aspx. 

For more information on User Account Control (UAC), refer to the Microsoft web site: 
http://www.microsoft.com/downloads/details.aspx?familyid=ba73b169-a648-49af-bc5e-
a2eebb74c16b&displaylang=en. 

To elevate a third party application that you do not own the source code for: 

Microsoft recommends writing a wrapper to invoke the application's executable (.exe) file in an 
elevated manner. If this is not feasible, GE Fanuc suggests the following: 

• Create a shortcut (.lnk) to the yourappname.exe, where yourappname is the name of the 
application you want to elevate.  
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• Right-click the shortcut and select Properties. Configure the shortcut to run as an 
Administrator.  



 

89 

Other iFIX Installation Considerations 
This chapter provides information you need to consider when using databases or drivers and iFIX. 
 This information includes: 

• Supported Drivers 

• Special Keyboard Buttons 

Supported Drivers 
iFIX supports the following drivers: 

• Version 6.x  

• Version 7.1 or higher  

NOTE: Version 7.01 drivers have known issues with iFIX and are not supported.  

If you want to run a driver on the Microsoft Windows Vista operating system, be sure to check with 
the vendor of your driver software to see if your driver supports Vista.  

Special Keyboard Buttons 
Some computer keyboards have special buttons for e-mail launch, internet launch, search, and other 
functions. These keyboard buttons may disable certain key macros or allow users to circumvent iFIX 
security measures.  

GE Fanuc recommends that you reprogram or disable the software that operates such special buttons. 
Refer to your computer's documentation for instructions on disabling these buttons. 
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Networking 
This chapter provides general information about the iFIX supported network protocol, supported 
network software, supported file servers, and installing network cards with Windows.  Refer to the 
following sections for more information: 

• Supported Networking Protocol 

• Supported File Servers 

• Handling Time Zones when Using Networked FIX 6.15 and iFIX Nodes 

• Networking with Other iFIX and FIX Nodes 

Supported Networking Protocol 
If you decide to implement a networked iFIX system, make sure that all nodes are using compatible 
network configurations. iFIX supports TCP/IP interfaces for peer-to-peer communication. NetBIOS is 
no longer supported. 

GE Fanuc has tested and recommends 3COM plug-in boards and built-in network adapters from 
Compaq, Dell, and Gateway. 

If you have difficulty networking your computer, refer to the Troubleshooting chapter of the Setting 
Up the Environment manual to pinpoint and resolve your problems. 

Supported File Servers 
GE Fanuc supports using a file server to store System Configuration Utility, alarm area database, 
security, historical, and recipe data files and file server-based iClients. iFIX does not require a file 
server.  

The following operating systems for file servers are recommended: 

• Microsoft Windows Server 2003.  

• Novell NetWare. If you use a NetWare file server, GE Fanuc recommends that you use 
Microsoft's Client Service for NetWare on your iFIX node.  

Refer to your file server documentation for installation and configuration instructions. 

If a file server becomes unavailable and an iFIX node attempts to access a file, you may experience no 
response, slow response, or time-outs. These conditions are a result of continuously polling all 
available drives while it waits for a response from the file server. It is recommended that you store a 
backup copy of the files you need on the local node. GE Fanuc does not recommend using the file 
server for files if it is susceptible to failure.  
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Handling Time Zones when Using Networked FIX 6.15 and iFIX 
Nodes 
In FIX 6.15, time zones are ignored when passing alarms over the network. For example, if a FIX 6.15 
node in Boston (Eastern Standard Time), generates an alarm at 4:00 PM, then a FIX 6.15 node in 
Chicago (Central Standard Time) displays that alarm with a time stamp of 4:00 PM.  

By comparison, iFIX uses time zones and adjusts the time stamp accordingly. For example, if an iFIX 
node in Boston generates an alarm at 4:00 PM, another iFIX node in Chicago displays the alarm with a 
time stamp of 3:00 PM.  

When FIX 6.15 and iFIX transfer alarms over the network, the time zone handling is similar to FIX 
6.15 as the following table shows.  

When... Then... 

A FIX 6.15 node in Boston generates an 
alarm at 4:00 PM 

An iFIX node in Chicago displays the alarm with a 
time stamp of 4:00 PM. 

An iFIX node in Boston generates an 
alarm at 4:00 PM 

A FIX 6.15 node in Chicago displays the alarm with a 
time stamp of 4:00 PM. 

Networking with Other iFIX and FIX Nodes 
iFIX 5.0 can share data and alarms with previous versions of iFIX, as well as with FIX32 6.15 and FIX 
v7.0. FIX32 view nodes will only receive alarms from alarm areas A-P. 

IMPORTANT: You cannot run iFIX and FIX v7 at the same time on a single computer. 
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Contact GE Fanuc 
If you purchased this product through a GE Fanuc Authorized Channel Partner, please contact them 
directly. 

General Contact Information 

• Online Technical Support & GlobalCare: www.gefanuc.com/support 

• Comments about our manuals or online help: doc@gefanuc.com 

• Additional information: www.gefanuc.com 

Technical Support 
If you have technical problems that cannot be resolved with the information in this guide, please 
contact us by telephone or email, or on the web at www.gefanuc.com/support. 

Americas 

• Online Technical Support: www.gefanuc.com/support 

• Phone: 1-800-GE FANUC (1-800-433-2682) 

• International Americas Direct Dial: 1-434-978-5100 

• Technical Support Email: support@gefanuc.com 

• Customer Care Email: customer.care@gefanuc.com 

• Primary language of support: English 

Europe, the Middle East, and Africa (EMEA) 

• Online Technical Support: www.gefanuc.com/support 

• Phone: +800 1 GE FANUC (+800-1-433-2682) 

• Technical Support Email: support.emea@gefanuc.com 

• Customer Care Email: customercare.emea@gefanuc.com 

• Primary languages of support: English, French, German, Italian, Czech 
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Asia Pacific 

• Online Technical Support: www.gefanuc.com/support 

• Phone: +86-400-820-8208 

•   +86-21-3217-4826 (India, Indonesia, and Pakistan) 

• Technical Support Email:  support.cn@gefanuc.com (China) 

•   support.jp@gefanuc.com (Japan) 

•   support.in@gefanuc.com (remaining Asia customers) 

• Customer Care Email: customercare.apo@gefanuc.com 

When You Have Questions 
Most questions deal with setup or normal operations. Our support representatives can normally answer 
these questions immediately. When you call: 

• Have your contract number ready. Your contract number is an eight-digit number that is a 
combination of your company's six-digit identification number and a two-digit extension that 
identifies the product you are using. It can be found on your invoice and in the body of your 
original packing list from GE Fanuc. If you are a member of our Extended Support Services 
program, your contract number is also on your customer support PhoneCard. 

• Be next to your computer so that the engineer can step you through the proper procedure. 

• Be familiar with your product's documentation so that the engineer can direct you to 
information on related topics. 

• Have the names and version numbers of the I/O drivers in use. 

• Know the HMI Application you are using. 

• Know the type of operating system you are using and the version number of your software. 

Assistance 
When you call for assistance with software that does not perform as you expect, the answer usually has 
to do with your computer's setup. You should be able to answer the following questions when you call: 

• What is the nature of the problem? Be as specific as possible. 

• Can you reproduce the problem easily? List the steps. 

• Can you still reproduce the problem after disabling all unnecessary third-party software? 
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• Do you encounter any error messages? What are they? 

What types of hardware are you using? List model numbers.  
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